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Preface
Summary of Changes
This section summarizes the enhancements to Distributed License 
Management (DLM) Release 3.3.

Release 3.3 Changes

This release offers the following enhancements:

� Support for Windows XP — Distributed License Management now 
includes support for Microsoft’s Windows XP operating system.

� Dynamic Debugging and Enhanced Error Messages — Distributed 
License Management has made it easier to diagnose a licensing fail-
ure with its enhanced error messages and ability to debug and trace 
activities. The standard error string has been modified to list all errors 
encountered in the license path as well as the most likely cause of 
failure.

� Remote License Administration Utility (RLAU) — This utility 
allows a remote administrator to view License Manager configura-
tions via a web browser (i.e., Internet Explorer or Netscape Naviga-
tor). Functionality includes viewing the License Manager 
components of the Log, License, and Options files. In addition, this 
tool offers the ability to monitor the usage of Compuware products 
and the state of License Managers that support them. For informa-
tion on this utility, see “Remote License Administration Utility” on 
page 81.

Note: The RLAU utility is product specific. Not every product will have this 
tool available for use.

� No Support for Novell — Distributed License Management no 
longer provides support for Novell network servers. 
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Chapter 1

Introducing Licensing
About This Guide
The License Installation Guide provides information and procedures to:

� Obtain a license

� Install concurrent-user licenses

� Install temporary licenses

� Install node-locked (single-user) licenses

� Perform license maintenance

� Troubleshoot license installation errors on Windows

Note: For definitions for many of the terms used in this guide, refer to the 
“Glossary” on page 101.

Overview of Licensing
Compuware’s software products are protected from unauthorized usage 
via a standard licensing mechanism. Compuware’s Distributed License 
Management software validates that an appropriate license is available. 
The licenses are provided in the form of a text file named license.dat 
or license.lic. These files can be installed on individual end-user 
desktops for temporary or node-locked licenses, or can be installed on a 
central License Manager server for centralized administration of licenses.

When a central License Manager is used, individual end-user machines or 
servers running Compuware products must know how to connect to the 
License Manager to obtain their license. To do this, use the License 
Administration Utility (LAU) on each target machine or use a UNIX 
environment variable to establish the host name and port of the 
machine running the License Manager.
 11



 

Licensing your Compuware product depends on several factors:

� The type of license file you received from Compuware.

� The number of users specified in your license file.

� The use of the License Manager or not.

This document provides all of the necessary information to administer 
the necessary licensing components required to run your Compuware 
product. Compuware’s licensing software consists of the following key 
components:

� The License Manager (LM) - A server (long running process) that ser-
vices requests for a license. The License Manager can be installed on 
many platforms, including Windows and UNIX. In many cases, it is 
recommended you collocate the License Manager with the server-
based component of one of the Compuware products you are install-
ing. 

� The License File (license.dat or license.lic) - A data file that con-
tains information about the license you have obtained for one or 
more Compuware products and features of those products.

� The License Administration Utility (LAU) - A Windows-based GUI 
used to configure the License Manager, install and apply license files 
you obtain, and to control license borrowing. The LAU is usually 
installed in your product directory, but may also be a separately 
installed component that can optionally be run from the product 
CD. See Chapter 4, “Using the License Administration Utility”.

� The Compuware Service Handler - An application (included in the 
LAU) that provides system administrators with the ability to start and 
stop the License Manager. To view the Compuware Service Handler 
choose Services>LMGRD from the LAU. See “Compuware Service 
Handler” on page 55.

� The Borrow Proxy Server - A Compuware licensing application that 
runs alongside the License Manager and enables License Borrowing 
activities. See “Overview of License Borrowing” on page 59.

� The Borrow License Client - A Windows-based GUI utility run on 
end-user desktops or laptops. This utility allows users to check 
licenses in and out. See “Borrow License Client” on page 72.

� The Remote License Administration Utility - A web-based tool that 
allows an administrator to perform simple license server administra-
tion using a browser. See Chapter 6, “Remote License Administration 
Utility”.
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Note: Some of the product components listed above are not supported by 
some Compuware products.

License Types

Some Compuware products allow a limited-time trial license automati-
cally without requiring installation of a license file. Others require a 
license file even for a trial. If you start your Compuware product without 
a license, it will either inform you that the license is missing or will tell 
you that an automatic time-limited trial has started. Each time you start a 
product on an automatic time-limited trial, you may be asked if you want 
to install a permanent license or to continue the trial. Before the trial 
runs out, you should acquire a permanent license from Compuware. See 
“Requesting a License from Compuware” on page 18.

Note: Not all products support all license types.
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Compuware offers several types of licenses. These licenses are described 
in the following table:

Table 1-1. Compuware License Types

License 
Type

Node-
Locked 1 Concurrent 2 Description

Permanent Yes Yes A permanent license gives you 
access to the Compuware product 
under the terms of your contract 
with Compuware. 

Temporary Yes Yes A temporary license has a fixed 
expiration date from the time it is 
installed on your system. You must 
request this license from Compu-
ware’s Sales Team. 

Trial Yes No A trial license is automatically 
installed when you install some 
Compuware products. When this 
is provided, it allows you to run 
the product for a specific time 
period (14-45 days from the day 
you install the product). Each time 
you start your Compuware prod-
uct, a message may appear 
informing you of the time left 
before the Trial license expires.

1. A Node-Locked license is a license that is tied to a particular machine via a unique 
identifier (generally the NIC MAC Address, but optionally a hard disk signature). For 
node-locked licenses, the use of the License Manager is not required, but can be 
used if you want a central place to store all of your licenses. *A Node-Locked license 
is denoted by the HOSTID keyword found in the license file. For more information 
on Node-Locked see “Licensing When the License Manager is Not Required (Node-
Locked)” on page 17.
2. A Concurrent (Floating) license is server-based and requires the use of a License 
Manager. This license allows you to share the use of a product with more than one 
user. *A concurrent license is denoted by the SERVER and DAEMON keywords in the 
license file. It allows you to use a specific number of licenses without assigning 
them to particular workstations. When all available licenses are checked out, no 
additional users can run the product until a license is checked back in. For more 
information on Concurrent see “Licensing When the License Manager is Required 
(Concurrent)” on page 16.

Note: *To review the contents of your license file, open license.dat or license.lic 
with Notepad, Vi, or another text editor. Commented lines start with a # 
(pound sign); all others are license file directives.
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Licensing Environment
It is often the case that multiple license files (or License Managers) are 
defined in a user's Licensing Environment. When a request is made to 
check out a license for a Compuware product, all environment paths in 
the Registry are scanned until a valid feature is found. 

For more information on license environments, see:

� For UNIX, “Setting the License Environment Variable for UNIX” on 
page 39.

� For Windows, “Current License Environment Setting Dialog Box” on 
page 48.

Before you attempt to run a particular product, be sure that one of the 
paths (environments) you have defined contains the license file with a 
feature line for the product you want to run. Also, if there are old/
obsolete paths in your environment setting, you should delete them to 
improve product response time. Therefore, only currently operating 
servers should be specified in the license environment setting.

Determining if You Need the License Manager
The first step in the licensing process is to determine whether or not it is 
necessary to install and run the License Manager on a server machine. If 
you have a trial or node-locked license, then you do not need to install 
the License Manager. However, the License Manager may be used with 
node-locked licenses for central administration of all of your licenses.

The License Manager (or license server) is a long running process serving 
multiple client machines, so most often you will install it on one central 
server machine for your entire organization. The License Manager can 
serve all of Compuware’s product lines—you do not need multiple 
license servers per product unless you are running redundant servers (see 
“Using Redundant License Servers” on page 17). Typically, you will 
install the License Administration Utility (LAU) on administrators’ 
desktops and use it to configure the License Manager.
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The following figures show product and licensing configuration for both 
pre-purchase and post-purchase of a Compuware product. 

Figure 1-1. Typical License Configuration for a Trial or Node-Locked Product

Figure 1-2. Typical License Configuration Using the License Manager

Licensing When the License Manager is Required (Concurrent)

A license file containing the SERVER and DAEMON lines is considered to 
be "concurrent" or "floating" and requires use of the License Manager. All 
other license files do not require a License Manager, but can be centrally 
stored, if desired, for administrative control. A concurrent license allows 
you to run a Compuware product on more than one client so that multi-
ple users can access the product. This means that you purchase a specific 
number of licenses without assigning these licenses to particular clients 
or having to obtain their unique node identifiers (NIC card address, etc.).

The Compuware License Manager keeps track of licenses as they are 
"checked out" and "checked in" by users. Licenses are "checked out" by 
users on a first-come, first-served basis when they access the product. 
After all available licenses are issued, no additional users can run the 
product until another user exits and a license is "checked in." Your license 
determines how many users may access the product at one time.
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The License Manager must be running on a computer or server that is 
always available to all clients needing access to the product. The License 
Manager can be installed on any of the following servers:

� For Windows, see Chapter 2, “License Installation and Management 
for Windows”.

� For UNIX, see Chapter 3, “License Installation and Management for 
UNIX”.

Licensing When the License Manager is Not Required (Node-Locked)

If your FEATURE line in the license file contains a “HOSTID=” string, you 
have a node-locked license. See Appendix B, “Host Name, Host ID, and 
HOSTID String”. This license file is tied to a particular machine via its 
NIC card address or disk id. 

When you have a node-locked license, installation is very straight-
forward: 

� you can install the license directly on the end-user desktop, in which 
case you do not need the License Manager, or 

� you can install the License Manager server to consolidate your 
licenses in one location.

Using Redundant License Servers
Tip: If a large number of 
licenses are governed by a 
single license server, 
failure of the server 
becomes a major event. 
To prevent problems, you 
may want to set up 
redundant servers so that, 
if one server goes down, 
the License Manager can 
still function.

Redundant License Management provides limited protection against 
license server failure by dispersing the responsibility of managing client 
licenses over a predetermined set of servers. This predetermined set 
consists of three independent servers.

When using redundant server licensing, you need to configure the same 
license file on three server machines. The license file must contain the 
names of each server and be installed on each server in the same order as 
they appear in the license file. You can edit the license file so that the 
servers are listed in any order, however, that license file version must be 
exactly the same on all three machines.

The first two machines listed in the license file are designated as potential 
masters and the third is designated as the slave machine. In a master-
slave relationship, two out of the three server machines must always be 
active in order to service licensing. Whichever of the first or second listed 
servers starts up first becomes the master server. It is recommended that 
the three servers be brought up in the order listed in the license file. 
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If the master server goes down, the other of the first two servers listed 
becomes the master. The third listed server is never the master. Its whole 
purpose is to help maintain a quorum. If the third machine goes down, 
then both of the first two servers must remain up in order to serve 
licenses. 

Required: When restoring a previously lost server, all three servers should be 
shut down and restarted in the same order listed in the license file.

For more information on setting up redundant servers on UNIX or 
Windows: 

� For UNIX, see “Setting Up Redundant Servers” on page 40.

� For Windows, see “Setting Up Redundant Servers” on page 50.

Caution: Redundant license servers do not work with borrow enabled 
licenses.

When You Need an Options File
If your license agreement allows an administrator to designate which 
specific users can access the Compuware product, then you need to 
create an Options File. If an options file is required, you can create it in 
Windows and FTP it to UNIX, or you can edit it manually in UNIX.

See Appendix A, “USER_BASED/HOST_BASED License Models” for more 
information on creating an options file.

Requesting a License from Compuware
To obtain a permanent license, you must provide the host information of 
the machine on which the license will reside. You can either e-mail the 
file hostinfo.txt to Compuware License Management at 
license_mgt@compuware.com or determine the host information and 
give that to Compuware. See Table B-1, Determining Host Information of 
Computer, on page 98 for procedures on determining the host informa-
tion.

You can also contact your sales representative. When you receive your 
license file from Compuware, copy the file onto a location on your disk 
and put it either:

� In the product directory for node-locked models. See “Current 
License Environment Setting Dialog Box” on page 48.
18     License Installation Guide



 

� In the license directory pointed to by the server on the license server 
machine. See “Configuring Clients to Access the License Manager on 
Windows Server” on page 28.

Supported Platforms
The following table lists the platforms upon which DLM components can 
be installed, licensed, and run. 

*Not recommended for Windows 95.

**XP is 32-bit only.

Getting Started
The remaining chapters in this manual discuss setting up the License 
Manager on different platforms as well as how to administer the License 
Manager or node-locked license file with the License Administration 
Utility (LAU). 

When you receive your license file from Compuware, it is recommended 
that you copy the file onto a location on your disk either:

Table 1-2. Supported Platforms

Platforms
Install 
License 
Manager

License 
Product

Install 
Borrow 
Proxy 
Server

Install 
Borrow 
Proxy 
Client

Alpha Open VMS - x - -

DEC (TRUE 64 
Open Alpha UNIX)

x x x -

HP-UX (32-/64-bit) x x x -

IBM-AIX (32-/64-
bit)

x x x -

Linux x x x -

Reliant x x - -

Sun-Solaris 2.x (32-
/64-bit)

x x x -

Windows - 95*, 98, 
Me, NT 4.0, 2000, 
XP**

x x x x
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� In the product directory for node-locked licenses without the use of 
the License Manager. See “Current License Environment Setting Dia-
log Box” on page 48.

� On the License Manager server for concurrent licenses or centrally 
administered licenses. See “Configuring Clients to Access the License 
Manager on Windows Server” on page 28.

To begin setting up the License Manager, refer to the chapter for your 
platform:

� For Windows, refer to Chapter 2, “License Installation and Manage-
ment for Windows”.

� For UNIX, refer to Chapter 3, “License Installation and Management 
for UNIX”.

License Installation Checklists

If you are installing a Compuware product with an automatic trial 
feature, you do not need to take any further action until you obtain your 
permanent license. Your trial license will allow you to use your Compu-
ware product between 14-45 days, depending on the product. 

The following checklists will assist you in the licensing process after your 
trial license has expired or if you are installing your permanent license. 
Please begin with the following:

❏ Determine the type of license you have. See “Determining if You 
Need the License Manager” on page 15.

❏ Determine the license model you will be using (Node-Locked or Con-
current). See “License Types” on page 13.

❏ If you are required to install the License Manager, see the “Installing 
the License Manager”checklist below.

❏ If you have a node-locked license and do not require the License 
Manager:

• Install the product.

• See “Using the License Administration Utility” on page 45.
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Installing the License Manager

Adding a New License to an Existing License File

License Borrowing for Administrators

❏ Select the platform (Windows or UNIX) on which the License Man-
ager will run.

• For Windows, see “License Installation and Management for Win-
dows” on page 23.

• For UNIX, see “License Installation and Management for UNIX” on 
page 33.

❏ Use the License Administration Utility (LAU) to:

• configure the license or

• add a new license to an existing license (see the “Adding a New 
License to an Existing License File” checklist) or

• assign the license file to the License Manager

See “Using the License Administration Utility” on page 45.

❏ Each client must connect to the License Manager to add the license 
path to their License Environment. See “Configuring Clients/Creating 
a License Environment” on page 49.

❏ If License Borrowing is enabled (for concurrent licenses only):

• For Administrators, see the “License Borrowing for Administrators” 
checklist below. 

• For Clients, see the “Borrowing a License for Clients”checklist 
below.

❏ If you will be using the Remote License Administration Utility (RLAU), 
see the “Using the Remote License Administration Utility 
(RLAU)”checklist below.

❏ If the terms “USER_BASED” or “HOST_BASED” are in your license 
files, see the “Using an Options File” checklist below.

❏ Start the LAU.

❏ See “Merge License Files Dialog Box” on page 53.

❏ You must have a concurrent license in order to use License Borrowing.

❏ If your license file has the keyword BORROW, you must install the Bor-
row Proxy Server when you install the License Manager, even if bor-
rowing will not take place. See  Chapter 5, “License Borrowing”.
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Borrowing a License for Clients

Using the Remote License Administration Utility (RLAU)

Using an Options File

❏ Configure the Borrow Proxy Server.

• For Windows, see “Borrow Proxy Server for Windows” on page 62.

• For UNIX, see “Borrow Proxy Server for UNIX” on page 69.

❏ Start the Borrow Proxy Server.

• For Windows, see “Starting the Borrow Proxy Server as a Service” 
on page 66.

• For UNIX, see “Starting the Borrow Proxy Server for UNIX” on 
page 69.

❏ Start the LAU.

❏ See “Borrowing a License” on page 75.

❏ Install and configure the RLAU. See “Creating User Accounts” on 
page 84.

• For Windows, see “Configuring in Windows” on page 87.

• For UNIX, see “Configuring in UNIX” on page 88.

❏ Start the RLAU. 

• For Windows NT, 2000, and XP, see “Windows NT, 2000, and XP” 
on page 88.

• For Windows 95, 98, ME, and UNIX, see “Windows 95, 98, ME, 
and UNIX” on page 89.

❏ Run the RLAU on the HTTP server. See “Configuring the Java Applet” 
on page 89.

❏ Create an Options file if one of your FEATURE lines contains a 
USER_BASED or HOST_BASED clause. 

❏ Modify the license file. See Appendix A, “USER_BASED/HOST_BASED 
License Models”.
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Chapter 2

License Installation and 
Management for Windows 
Overview of License Installation for Windows
The procedures in this chapter will describe how to install the License 
Manager on a Windows server. You can use Windows 95, 98, Me, NT, 
2000, or XP as the server to host the License Manager. 

Note: Installation of the License Manager is only required for Concurrent 
license types (SERVER and DAEMON lines are present in the license 
file). Installing the License Manager is NOT required if you have a 
node-locked license (see “Licensing When the License Manager is 
Not Required (Node-Locked)” on page 17). 

Depending on the type of license you have, the following steps may be 
necessary to install and operate the License Manager in your environ-
ment:

1 Install the License Manager and its components. See “Installing the 
License Manager for Windows” on page 24.

2 Configure the License Manager and its components to run as services 
using the Compuware Service Handler via the License Administration 
Utility.

3 Configure each client to access the License Manager. See “Configur-
ing Clients to Access the License Manager on Windows Server” on 
page 28.

4 Configure the Borrow Proxy Server to run as a service using the Com-
puware Service Handler, if product is borrow-enabled. 

5 Configure each client’s Borrow License Client application to talk to 
the Borrow Proxy Server, if product is borrow-enabled.

6 Create an Options file, if necessary. See “Creating an Options File” on 
page 93.
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Installing the License Manager for Windows
The following procedures walk you through the installation and configu-
ration of the License Manager and the Borrow Proxy Server.

Before installing the License Manager and its components, note that it 
may not be necessary to completely install the new License Manager. See 
“Updating the License Manager on Windows” on page 28.

Note: If you are updating a license file only (not the License Manager), it is 
recommended that you merge the new license file with the existing 
one. After the new license file is merged, use the Compuware Service 
Handler to reread this new master license file. See “Merge License 
Files Dialog Box” on page 53 for more information on merging 
licenses.

1 From your Compuware product installation CD, select Install (Com-
puware) License Manager. This will start the InstallShield Wizard for 
the License Manager. You will need to navigate through several 
screens to proceed through the InstallShield Wizard. The screens will 
require you to perform tasks such as: 

� read and accept the License Agreement

� provide Customer Information

� choose your Destination Location

Required: If you do not use the default install directory for License Manager, 
and you have an existing License Manager, you must uninstall the 
original License Manager, reboot, and install the new version.

� select a Program Folder

� start Copying Files

2 Click the Next button after completing each screen of the 
InstallShield Wizard.

3 After you click the Next button to copy the files, the setup will begin 
and you will be asked if you want to install a license.

Figure 2-1. License Installation Question Dialog Box
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� If you want to install a license, click Yes and the License Installa-
tion Server dialog box appears (see Figure 2-2). Compuware rec-
ommends you select Yes, which will allow you to continue the 
installation process and install the License Manager.

� If you click No, you will exit the InstallShield Wizard and will 
need to configure the License Environment and the Borrow 
Proxy Server using the LAU. See Chapter 4, “Using the License 
Administration Utility” for more information on creating a 
license environment and starting the Borrow Proxy Server. 

4 After you click the Yes button, you will be asked if you have a server 
license for this machine.

Figure 2-2. License Installation Server Dialog Box

� If you have a server license for the machine where you are work-
ing, click Yes and the Compuware Service Handler screen displays 
(see Figure 2-3).

� If you select No, you will need to launch the LAU to acquire your 
system information and continue installing the License Manager. 
See Chapter 4, “Using the License Administration Utility” for 
more information on creating a license environment and starting 
the Borrow Proxy Server. 
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5 In the Compuware Service Handler dialog box type in, or click the 
Browse button to find, the appropriate log file and license file names 
in the Log File Name and License File fields.

Figure 2-3. Compuware Service Handler Dialog Box

6 Click Continue. You will be asked if you want to start and install the 
Compuware License Manager as a service.

� If you do, click Yes. This will start the service. Click Continue 
again to complete the installation.

� If you click No, you will have to manually start the License Man-
ager after completing the installation. See “Compuware Service 
Handler” on page 55.

If the License Manager is already installed as a service, you will 
receive multiple messages indicating this. Also, the log file will be 
written to and automatically opened.

Installing the Borrow Proxy Server

During the installation and configuration of the License Manager, you 
may also be prompted to install the Borrow Proxy Server (BPS) if your 
license file has the keyword BORROW.
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Required: If the keyword BORROW is present in your license file, the Borrow 
Proxy Server MUST ALWAYS run in conjunction with the License 
Manager, even if Borrowing will not take place. 

1 The license is automatically scanned and checked for the BORROW 
keyword. If it is present, the following dialog box appears:

Figure 2-4. License Installation Borrow Enabled Dialog Box

If you select Yes, the Borrow Proxy Server screen displays with the 
current machine’s Server Name and Port Number fields already 
displayed. 

2 Click the Start BPS button. 

3 You will be asked if you want to run BPS automatically when you 
restart your system. If so, click Yes. If you click No, you will have to 
manually start the BPS each time the server machine reboots.

Tip: For Windows NT, 
2000, and XP, the Borrow 
Proxy Server screen is only 
a portal to the service 
itself, so you may close 
the dialog box. For 
Windows 95, 98, and ME, 
the dialog box itself must 
remain open or the BPS 
will be stopped and 
licenses will not be 
authorized for checkout.

4 You will receive a message indicating whether or not the installation 
of the BPS as a Service was successful. 

5 Go back to the Compuware Service Handler dialog box and click 
Continue.

6 On the InstallShield Wizard dialog box, click Finish to close the 
InstallShield Wizard. 

Where To Go Next

� It is also necessary to configure each client's machine to access the 
License Manager (see “Configuring Clients to Access the License 
Manager on Windows Server” on page 28). 
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� If your License File contains the keyword BORROW, you need to set 
up each client to use the Borrow License Client utility (see “Borrow 
License Client” on page 72).

� If you are using an Options file, see Appendix A, “USER_BASED/
HOST_BASED License Models”.

� To access the Borrow Proxy Server, see “Borrow Proxy Server for Win-
dows” on page 62. 

� To access Compuware Service Handler, see “Compuware Service Han-
dler” on page 55.

� To access Borrow License Client from the LAU, see “Borrow License 
Client” on page 72.

Configuring Clients to Access the License Manager on Windows 
Server

When using a Concurrent license model, each client must be configured 
to access the License Manager. Each client does not have an individual 
license, i.e, the client will connect to the Master License file which is 
served by the License Manager. The Master License is the license used by 
the License Manager. The COMPUWARE_LICENSE_FILE registry variable 
is set using the LAU. This setting is used to connect the client to the 
license file. There are two ways to configure clients to access the License 
Manager:

� Configure Clients with the License Administration Utility (see “Con-
figuring Clients/Creating a License Environment” on page 49)

� Configure Clients during product installation (see “Configuring Cli-
ents During Product Installation” on page 47)

After the client's License Environment is set, and if License Borrowing is 
enabled, verify that the Borrow License Client is configured on the client 
machine (for more information, see Chapter 5, “License Borrowing”).

Updating the License Manager on Windows

Required: If you are upgrading to version 3.3 of Compuware’s Distributed 
License Management software and even if you have a previous 
version of the license management software, you must install the 
28     License Installation Guide



 

License Manager and all of its components to enable License 
Borrowing and the Compuware Service Handler.

If you are hosting the License Manager on a Windows server, follow the 
instructions below to find out if you need to update or install the License 
Manager.

Install the License Manager only if no previous version of the License 
Manager exists on the server. 

Update the License Manager if a lower version of the License Manager 
exists on the server. Compare the version number already on the License 
Manager server with the version number on the product CD. To compare 
the version numbers perform the following steps:

1 Determine the version number already on the License Manager 
server:

a At the DOS prompt, navigate to the directory where the License 
Manager is located.

b Type the following command at the DOS prompt:
lmutil lmver lmgrd.exe

c Press Enter and a message similar to the following will display.

lmutil - Copyright (C) 1989-2001 Globetrotter Software, Inc.
FLEXlm v7.2i (liblmgr.a), Copyright (C) 1988-2001, Globetrotter 
Software, Inc.

2 Determine the version number on the product CD:

a Insert the product CD, open a DOS prompt, and navigate to the 
directory of the CD.

b Type: lmutil lmver lmgrd.exe and press Enter to display the 
version information.

c If the CD has a newer version, update the License Manager by 
selecting the option on the product CD for installing the Compu-
ware License Manager.

Uninstalling the License Manager or Borrow Proxy Server
There are two methods you can use to uninstall the License Manager and 
its components from your system. You can delete the application in DOS 
from the command prompt or remove the programs using Windows. 
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Method 1

1 Using a DOS command prompt, navigate to the License Manager/
Borrow Proxy Server root directory.

2 For the License Manager, type: flxsrv -del and press Enter.

3 For the Borrow Proxy Server, type: bps -del and press Enter.

4 Click Yes to proceed.

Method 2 

1 From the Start menu, choose Settings>Control Panel.

2 Double click the Add/Remove Programs icon to display the Add/
Remove Programs Properties dialog box.

3 Select Compuware License Manager from the list of programs.

4 Click the Add/Remove button to display the InstallShield Wizard.

5 Follow the instructions on the screen to proceed through the unin-
stall process.

Troubleshooting Errors on Windows

License Server is Not Listed in Services List

This only applies to Windows NT, 2000 and XP; other Window’s versions 
do not have Services lists. To check your Services list:

1 From the Start menu, choose Settings>Control Panel.

2 Double click the Services icon to display the Services dialog box.

If you did not install a permanent license when the License Manager was 
installed, the License Server service was not installed. See “Installing the 
License Manager for Windows” on page 24.

License Server Does Not Start

� If the machine was not rebooted after installation, try rebooting.

� The specified Host ID does not match the machine Host ID.

� To start the License Manager, choose Start>Programs>Compu-
ware>License Manager from the Taskbar. If the License Manager 
does not start, it may produce an exception error to assist in trouble-
shooting. 
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� The license file specified as the master license file has been moved or 
is not located in the specified directory. You may not be able to see a 
file if your folder settings are preventing you from doing so. To verify 
that your settings are correct:
a Open Windows Explorer.

b From the View menu, choose Options. The Options dialog box 
appears.

c On the View tab, verify that the Show all files option is selected.
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Chapter 3

License Installation and 
Management for UNIX
Overview of License Installation for UNIX
The licensing process varies based on the Compuware product being 
installed, your agreement with Compuware, and the platform on which 
the License Manager is installed. Some Compuware products are installed 
on the client (node-locked) and do not require the License Manager 
product, while concurrent licenses do require the installation of the 
License Manager.

Note: If your license has SERVER and DAEMON lines, then you need to 
install the License Manager. The only time that you do NOT need to 
install the License Manager is if you have a Node-Locked license. If 
you have a Node-Locked license for a client machine, all you need to 
do is set the LM_LICENSE_FILE environment variable. See “Setting 
the License Environment Variable for UNIX” on page 39.

When a License Manager is needed, setup involves the following steps:

1 Install the License Manager and its components. See “Installing the 
License Manager on UNIX” on page 34.

2 Configure License Manager to start whenever the server boots. See 
“Starting the License Manager” on page 35.

3 Configure each client to access the License Manager. See “Setting the 
License Environment Variable for UNIX” on page 39.

4 Configure the Borrow Proxy Server to start whenever the server 
boots, if product is borrow-enabled.

5 Create an Options file, if necessary. See “Creating an Options File” 
on page 93.
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Installing the License Manager on UNIX
Before installing the License Manager and its components, note that it 
may not be necessary to completely install the new License Manager. See 
“Updating the License Manager on UNIX” on page 37.

1 Mount the CD-ROM on your system (root access required).

2 Check to see if the License Manager is already running by typing in 
the following command in the Licensing Components directory:

lmutil lmver lmgrd

3 The License Manager messages will indicate if it is already running. If 
it is running, type the following to bring it down:

lmutil lmdown -c <license file>

4 Change to the mount directory. For example, if /cdrom is the mount 
directory, type the following: cd /cdrom

5 Navigate to the directory on the CD that contains the Compuware 
executable license files for the platform on which you are setting up 
the License Manager. The path is:

<CD drive>\cpwr\cwlm\directory name

Refer to the table below for the directory name for each platform.

6 Type the following to install the License Manager on your system: 

./install

7 The install script will ask the name of the target directory for the 
License Manager. We suggest /usr/local/cwlm (root access required 
to create the directory). You will be notified when install is complete. 

Table 3-1. UNIX Directories

Platform Directory Name

IBM-AIX 64-bit cwlmaix64.32

IBM-AIX 32-bit cwlmaix32.32

DEC cwlmdec.32

HP-UX 64-bit cwlmhp64.32

HP-UX 32-bit cwlmhp32.32

Linux cwlmlinux

Sun-Solaris 2.x 64-bit cwlmsun64.32

Sun-Solaris 2.x 32-bit cwlmsun32.32
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(If install has a problem creating the directory, you will be notified of 
the error and exit.)

8 Before you can start the License Manager, you must supply Compu-
ware with the host ID of the node on which you plan to run the 
License Manager. To get this ID, type the following command within 
the directory created previously: lmutil lmhostid

9 The ID the Licensing System uses for validation is displayed. You 
must send this ID to Compuware. Compuware will then send back a 
license file that replaces the temporary or trial license.dat in the 
license file directory (usually /usr/local/cwlm).

Required: You must receive a new license file from Compuware before 
proceeding to “Starting the License Manager” on page 35.

Uninstalling the License Manager on UNIX

To uninstall the License Manager and remove the license file directory 
and its contents, type the following command: 

rm -r /usr/local/cwlm

Caution: Be sure to save your license files before removing the license 
file directory.

Starting the License Manager
The License Manager can be configured to start automatically (each time 
the server boots) or to start manually.

To validate the license for Compuware products, the License Manager 
needs to be running whenever a client requests a license check out. 

1 Verify that the licensing components are installed, including the 
license file.

2 Navigate to the directory containing the License Manager.

3 Ensure that the License Manager is shut down. Check to see if the 
License Manager is already running by typing one of the following 
commands: 

� lmutil lmstat -c <license file>

� or the UNIX command: ps -e|grep lmgrd

The license utility messages will indicate if it is already running.
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Required: You cannot run two License Managers simultaneously and must 
shut one down before starting a new one. 

4 Do one of the following:

� To start the License Manager manually (required each time the 
Server reboots), type the following:

lmgrd -c /fullpathname/license.dat > license.log &

� To start the License Manager automatically each time the 
Server reboots, follow the suggested procedure below for the 
appropriate platform:

5 If License Borrowing is enabled (a license file containing a FEATURE 
line with the BORROW keyword), you may want to install the Bor-
row Proxy Server to start automatically with the License Manager. To 
do so, enter the following command:

nohup bps.run -c <license_file> -p <port_#> -l 
<log_file> &

Table 3-2. Suggested Automatic Startup Per Platform (UNIX)

Platform Action

AIX In etc/rc.local, enter the following command on one 
line:

nohup /etc/lmgrd -c /cpwr/license/
license.dat>license.log2>&1&

HP-UX In /sbin/rc3.d, create a file named s95cwlm.server 
and add the following command to the file:

nohup lmgrd -c /cpwr/license/
license.dat>license.log&

Linux In /etc/rc.d/rc2.d, create a file named 
s95cwlm.server and add the following command to the 
file:

nohup lmgrd -c /cpwr/license/
license.dat>license.log&

Sun Solaris In /etc/rc2.d, create a file named s95cwlm.server and 
add the following command to the file:

nohup lmgrd -c /cpwr/license/
license.dat>license.log&
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Preventing Users From Bringing Down the License Manager

To prevent users from bringing down the License Manager, use the -p -2 
option which goes directly after the lmgrd reference for any of the 
platforms in Table 3-2 on page 36. If this option is selected, only Admin-
istrators with root privileges can bring down the LM: nohup path_to/
lmgrd -p -2 -c /path_to/license.dat > license.log &

Updating the License Manager on UNIX
Follow these instructions below to update the License Manager on a 
UNIX server. To determine whether to install or update the License 
Manager, use the following guidelines:

Install only if no previous version of the License Manager exists on the 
machine you chose as the License Manager server. From the Compuware 
product CD, copy the contents of the platform-specific /cpwr/cwlm 
subdirectory to a directory named /cpwr/license on your License 
Manager server. See “Installing the License Manager on UNIX” on page 
34.

Update if a lower version of the License Manager exists on the machine 
you chose as the License Manager server. Compare the License Manager 
version number already on the License Manager server (by navigating to 
the directory where the License Manager is located) with the version 
number on the product CD. To do so, follow these steps:

1 Navigate to the directory on the Server where the License Manager is 
located. Type the following and press Enter: lmutil lmver lmgrd 

� In the response message, make note of the License Manager ver-
sion number. 

2 Navigate to the directory on the product CD where the License Man-
ager is located. Type the following and press Enter: lmutil lmver 
lmgrd

� In the response message, make note of the License Manager ver-
sion number. If the License Manager version number on the 
product CD is greater than the License Manager version number 
on the server, proceed to install.
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License Administration Utility for UNIX 
Tip: Globetrotter, the 
company that created the 
License Manager, created 
the lmutil utility. See the 
Globetrotter FLEXlm 
documentation for more 
information.

The lmutil utility allows you to perform administrative tasks for the 
license manager. The format for this utility is as follows:

lmutil command [option1 option2 ...]

Example:

lmutil lmstat -a

Table 3-3. Commands and Options for lmutil

Command Argument Description

lmdown -c pathname Performs a graceful shutdown of the 
License Manager. This argument is 
needed if you specified a location for 
the license file other than the default 
and you have not set the 
LM_LICENSE_FILE environment vari-
able. 

lmhostid Returns the hostid of the machine on 
which you are currently running. This is 
the ID that must be sent to Compuware 
in order for you to receive a permanent 
license file for your License Manager 
machine. 

lmstat -a Displays all information

-A Lists all active licenses

-c pathname Required if you specified a location for 
the license file other than the default 
and you have not set the environment 
variable LM_LICENSE_FILE.

lmver [file] Reports which version of security a 
product (binary file) has.

lmdiag Performs diagnostics to troubleshoot 
problems with the License Manager sys-
tem.

-c pathname Needed if you specified a location for 
the license file other than the default 
and you have not set the environment 
variable LM_LICENSE_FILE.

[feature] Diagnose this feature only

-n Run in non-interactive mode.
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Setting the License Environment Variable for UNIX
If License Manager is required (concurrent license), each client must be 
configured to automatically access the License Manager or license file. If 
the License Manager is not required (node-locked license), a license file is 
required on each client machine. The LM_LICENSE_FILE environment 
variable is used on UNIX systems to set the license path (Windows uses 
COMPUWARE_LICENSE_FILE registry variable). Follow the procedures 
below for your platform. 

Set the LM_LICENSE_FILE environment variable in the global environ-
ment using the appropriate command for your particular shell. This will 
configure each UNIX Client to access the License Manager or license file.

C shell

If the client is accessing a license file on the client machine (node-
locked), use:

setenv LM_LICENSE_FILE /<full path to license>/
license.dat

Tip: The Port number is 
typically 7166.

If the client is accessing the License Manager on a server (concurrent), 
use:

setenv LM_LICENSE_FILE 7166@<hostname>

Bourne shell

For the Bourne shell a two line command is used:

If the client is accessing a license file on the client machine (node-
locked), use:

a LM_LICENSE_FILE=/<full path to license>/license.dat

b export LM_LICENSE_FILE

If the client is accessing the License Manager on a server (concurrent), 
use:

a LM_LICENSE_FILE=PORT@HOST

b export LM_LICENSE_FILE

Korn shell

If the client is accessing a license file on the client machine (node-
locked, use:

export LM_LICENSE_FILE=/<full path to license>/
license.dat
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If the client is accessing the License Manager on a server (concurrent), 
use: 

export LM_LICENSE_FILE=7166@<hostname>

Setting Up Redundant Servers

After you install the License Manager on all three server machines in the 
redundant configuration, you must edit the license file created during 
these installations to include the additional Ports and Hostnames. 

Tip: Remember to 
separate the paths with a 
colon.

For example on servers Hostname1, Hostname2, and Hostname3 on Port 
7166, the LM_LICENSE_FILE environment would read:

...7166@Hostname1:7166@Hostname2:7166@Hostname3...

UNIX Components
The installation directory for the UNIX platform includes the following 
files:

Table 3-4. Unix Platform Directory

File name Description

lmgrd License Manager

compuwar Vendor daemon

lmutil Utility for administering the License Management system

cl_merge License Merge utility

cl_sort License Sort utility

cl_valid License Validation utility

flexlm.rul Rule file used by cl_valid

bps.stat Status checker of Borrow Proxy Server 

bps.run Borrow Proxy Server

bps.cfg Create this file to set Borrow restrictions. (File not shipped. 
File must be created by the customer.)

bps.stop File created when bps.run is started. (File not shipped. File 
must be created by the customer.)

install Installation script

aes Admin Edit Script
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lmgrd 

The License Manager application itself.

compuwar

The vendor-specific daemon produced by the lmgrd.

lmutil 

The License Administration Utility for the lmgrd created by Globetrotter 
Software. See “License Administration Utility for UNIX” on page 38.

cl_merge

A script file called by the install script. This script will manually sort and 
merge together two license files. 

Syntax: 

cl_merge -t <target_master_lic_file> -s <source_file> 

� <target_master_lic_file> is the target (destination) master 
license file with which the new (source) license file will be 
merged

� <source_file> is the new license file that is to be merged with 
the target_file 

Sample script usage: 

#!/bin/sh

cp $1 $1% 

echo "merging $1 $2" 

echo "A backup has been written to $1%" 

cl_merge $1 $2 

cl_sort

This script sorts an existing license file and is called by cl_merge. It 
requires a license file as its only argument.

Syntax:

cl_sort <license_file>

cl_valid

This script validates a license file. It prints errors to stdout. 

Syntax:
Chapter 3� License Installation and Management for UNIX      41



 

cl_valid -l <license_file> -r <flexlm.rul_file>

� <license_file> is a license file that is to be scanned for errors

� <flexlm.rul_file> is the rule script file that is to be run 
against the license file

flexlm.rul 

Rule file used by cl_valid.

bps.cfg

An optional file that is used with borrow-enabled licensed components. 
See “Borrow Proxy Server for UNIX” on page 69.

bps.run

A file that brings up the Borrow Proxy Server.

Syntax: 

bps.run -c <license_file> -p <port_number> -l <log_file> 

� The license_file argument must contain a license file with a 
FEATURE line that has the keyword BORROW.

� Port number must be unique on the network.

See “Borrow Proxy Server for UNIX” on page 69.

bps.stat

This utility reports the status of the Borrow Proxy Server.

Syntax:

bps.stat (with no arguments)

See “Borrow Proxy Server for UNIX” on page 69.

bps.stop

This file is not shipped on the CD-ROM and is created when bps.run is 
issued. Use bps.stop to shut down the Borrow Proxy Server.

install

The install file is an install script for the License Manager. See “Installing 
the License Manager on UNIX” on page 34.
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aes

The aes file is a configure script for the License Manager. 
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Chapter 4

Using the License 
Administration Utility
Overview of License Administration Utility
The License Administration Utility (LAU) is a Windows-based interface to 
both the License Manager and the license file. It can be run directly from 
the product CD. Many products also install this component in the 
product directory for quick access. The file name is lau.exe.

Figure 4-1. The License Administration Utility

Functions of the LAU

The functions of the LAU include:

� Install a license — The Compuware License Install dialog box is dis-
played if a product requests a license that does not exist anywhere in 
the user’s Current Licensing Environment. See Figure 4-2 on page 47.

� To set up the Environment before the product starts, see “Cur-
rent License Environment Setting Dialog Box” on page 48.

� To merge a new license file with an existing Master License File, 
see “Merge License Files Dialog Box” on page 53.

Required: When setting up the components, the person who uses the 
product must have the same access privileges as the person or 
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administrator who installs the client portion of the license compo-
nents. If a system administrator installs the client portion and a 
user does not have the same privileges, then the user may not be 
able to use the license.

� Modify the Current License Environment Setting — The License 
Environment provides users with add/remove paths to different 
License Managers and license files. See “Current License Environ-
ment Setting Dialog Box” on page 48.

� Verify Host information — The LAU displays Host information in 
its top pane. You can create and save a file with Host information. 
This file can be used to request a permanent license when sent to 
Compuware. See Appendix B, “Host Name, Host ID, and HOSTID 
String” and “Requesting a License from Compuware” on page 18.

� Verify license FEATURE line status — When a License File or 
License Manager is selected in the license file or server drop down 
box, the file is scanned and the status of all FEATURE lines are dis-
played. This option is a reporting mechanism only and does not 
“Set” a specific path—all paths in the Environment are always 
scanned when a product requests a license file. See “Checking the 
License Manager Status” on page 55.

� Compuware Service Handler — The Compuware Service Handler 
allows System Administrators to start and stop the License Manager 
service and reread a license in addition to other functionality. See 
“Compuware Service Handler” on page 55.

� Borrow License Client — The Borrow License Client allows clients to 
disconnect from the server and still use a licensed Compuware prod-
uct. See “Borrow License Client” on page 72.

� Borrow Proxy Server — The Borrow Proxy Server handles client 
requests to borrow licenses submitted by a Borrow License Client and 
must run whenever the License Manager is running. See “Borrow 
Proxy Server for Windows” on page 62.

Compuware License Install Dialog Box
The Compuware License Install dialog box appears when a Compuware 
product requests a license from the License Manager and the license does 
not exist anywhere in the client's License Environment Setting. To add a 
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license, use the Browse button to navigate to the license file, or type in 
the Port@Host location of a License Manager.

Figure 4-2. Compuware License Install Dialog Box

� Current License Status field — Shows the Product/Release items that 
are available for licensing.

� License File Location field — Enter a path to the license file or 
License Manager or click the Browse button to locate the file.

� View License Information button — Allows users to see more details 
regarding the license.

� Continue button — Click this button to continue product installa-
tion after a successful product install.

See “Configuring Clients During Product Installation” on page 47 for 
instructions on using this screen.

Configuring Clients During Product Installation

It is also necessary, during product installation, to configure each client’s 
machine to access the License Manager. The following are instructions on 
using the Compuware License Install dialog box which will display 
during the installation process.

1 The License Install dialog box is used to connect to either the License 
Manager or a license file; it can also run a trial license of a product. 

� To connect to a License Manager, enter the Port@Host location 
of a License Manager. You will not be required to merge a license 
file; you will be using the license file that the system administra-
tor is using in conjunction with the License Manager.

� To connect to a local license file, select a product in the Prod-
uct/Version list and then type in the path or click the Browse 
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button and navigate to the license file. If you already have a 
license file, you will be required to merge the new license file 
with the existing master license file. For information on merging 
license files, see “Merge License Files Dialog Box” on page 53. 
After you merge a new license with a master license file, the pre-
vious version of the master license file will be archived and 
named License.dat%.

2 If you get the following message: "License Manager must be installed 
and started on this machine…", then your license file contains a 
SERVER or DAEMON line and the License Manager must be installed 
first. (See “Installing the License Manager for Windows” on page 24.)

3 Return to the product installation.

Current License Environment Setting Dialog Box
The Current License Environment Setting dialog box allows users to 
define multiple licensing environments for a machine. To open this 
dialog box, choose Tools>License Path from the LAU. When a new 
License Environment is created, it will be appended to the 
COMPUWARE_LICENSE_FILE variable in the Registry. (See “Configuring 
Clients/Creating a License Environment” on page 49).

Figure 4-3. Current License Environment Setting Dialog Box

� Current License Environment Setting field — The first field, to the 
left of the Move button, in the Current License Environment Setting 
dialog box displays all currently defined license fields. To remove an 
item from the list, double-click the item. See “Editing Existing 
License Environment Paths” on page 52.
48     License Installation Guide



 

� Move button — Allows users to change the order of the items listed 
in the Current License Environment Setting field. When a Compu-
ware product attempts to check out a license, it will search all of the 
paths in the listing (License Manager or License.dat file) until it finds 
a valid feature line. Therefore, if many paths/environments are speci-
fied, setting the most frequently used paths/environments to the top 
of the list will increase the speed at which the Compuware product 
checks out a license.

� New License Environment field — This field is to the left of the 
Browse button and is used to add an entry to the Current License 
Environment Setting field. Type the Port@Host location or use the 
Browse button to locate a license file.

� See “Adding a Path to the Current License Environment” on page 
52.

� See “Editing Existing License Environment Paths” on page 52.

� Append button — Add the path by typing the path name or click the 
Browse button to find the path name. Click the Append button to 
add the path to the Current License Environment Setting field. 

� Apply Changes button — Applies any changes made while the dia-
log box is open, including adding, editing and removing licenses, or 
reordering the paths in the list. 

Configuring Clients/Creating a License Environment

All clients need to add the new license file to their License Environment 
in order to use the product after a trial period has ended. For Concurrent 
Licenses, the License Manager needs to be installed and run as a service 
on a separate server. 

1 Install the Compuware Product.

Note: Concurrent licenses only: Have your system administrator give you the 
location of the License Manager. 
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2 Start the LAU.

Figure 4-4. The License Administration Utility

3 From the Tools menu, choose License Path. 

Tip: The Port number is 
typically 7166.

4 Type the Port@Host server location of the License Manager in the 
Current License Environment Setting field which is to the left of 
the Browse button. Each location specified in the Current License 
Environment Setting field will be scanned when a Compuware prod-
uct requests a license.

5 Click the Append button.

6 Click the Apply Changes button. The location of this License File/
Server has been set in the registry. Compuware products look at this 
registry setting for the location(s) of a valid license.

7 Close the dialog box. 

Setting Up Redundant Servers

Each client machine must have an entry in its license path to each of the 
three redundant servers. Each of the three redundant servers should be 
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added to the environment. This is done by performing the following 
steps.

1 From the Tools menu, choose License Path to display the Current 
License Environment Setting dialog box. 

Figure 4-5. Current License Environment Setting Dialog Box

2 Add each of the three redundant servers to the environment by typ-
ing the Port@Host server location of the License Manager in the Cur-
rent License Environment Setting field which is to the left of the 
Browse button. 

� You can add each server individually and change the order of the 
items (see Figure 4-5) using the Move button.

� Or you can list all three servers in one line (see example below).

Tip: Remember to 
separate the paths with a 
semi-colon.

For example, on Servers A, B, and C on port 7166, the line 
would read:

7166@Server A;7166@Server B;7166@Server C

3 Click the Append button.

4 Click the Apply Changes button.

5 Close the dialog box.

Although it is not necessary to have the three servers listed in the same 
order as they appear in the license file, it is operationally more efficient 
to have them in the same sequence.
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Adding a Path to the Current License Environment 

1 Start the LAU.

2 From the Tools menu, choose License Path.

3 Use the Browse button to locate a license file, or type in a path to a 
license file or a server with a Port@Host string in the Current License 
Environment Setting field.

4 Click the Append button.

5 Close the dialog box.

Editing Existing License Environment Paths

1 Double-click a path in the Current License Environment Setting 
field. The path will be removed from the Current License Environ-
ment Setting field and will be placed in the New License Environ-
ment field for editing.

2 Make changes to the field and then click the Append button.

3 Click the Apply Changes button.

Removing a Path Within the Current License Environment 

1 Start the LAU.

2 From the Tools menu, choose License Path.

3 Double-click the path in the Current License Environment Setting 
field to remove it from the list.

4 Click the Apply button.

5 Close the dialog box.

Viewing the License Variable in the Windows Registry

You can use the registry to verify changes made to the License Path. The 
path is located in the following registry location:

HKEY_LOCAL_MACHINE/SOFTWARE/FLEXlm License Manager/
COMPUWARE_LICENSE_FILE. 

The location of the license file can be found in the Window’s Registry:

1 At a command prompt, type REGEDIT. 

2 When the Registry Editor Window opens, select the 
HKEY_LOCAL_MACHINE node and click the plus sign to expand it.
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3 Click the SOFTWARE node and click the plus sign to expand it.

4 Click on the FLEXlm License Manager node. The 
COMPUWARE_LICENSE_FILE variable will contain a value indicat-
ing the path(s) to all of the license files or License Managers.

Merge License Files Dialog Box
The Merge License Files dialog box allows users to enter a source and 
target license file and have the LAU automatically merge them. Compu-
ware recommends keeping all license files in a single Master License File 
(created in the merge process) for easier maintenance. When two license 
files are merged together, they are simply combined and referred to as a 
"Master License File". 

Figure 4-6. Merge License Files Dialog Box

The Merge License Files dialog box contains the following features:

� Target field — The Target Field in the Merge License File dialog box 
describes the original, existing license file. 

� Source field — The Source Field in the Merge License File dialog box 
describes the new license file that will be added to the Target field 
license file.

� Merge button — The Merge button will begin the merge process. See 
below.
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Merge Process

During the merge process the following will happen:

1 The source file (new license file) will be opened and merged with the 
target file (original Master License File) creating a new Master License 
File.

2 The new Master License File will be sorted by the ISSUE DATE string 
in each FEATURE line. 

Note: The merge process will NOT comment out any lines or remove any 
lines from either the source or target files.

3 After the merge process is complete, the new Master License File will 
be put through an internal "Validity Check".

4 If the Master License File contains errors, then an error dialog box 
will appear. The error dialog box will have Abort/Continue buttons. 

� If you click the Continue button on a Master License File con-
taining errors, the Master License File will be saved with errors. 

� If you click the Abort button, then the original license file (the 
target file, in step 1) will be restored.

Caution: If you are unsure about the meaning of the error or how to pro-
ceed, do not click the Continue button. Contact Compuware’s Technical 
Support for assistance. At this point, you may click the Abort button to 
exit the merge process or keep the error message on the screen.

5 A backup copy of the file is saved with the name License.dat%.
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Checking the License Manager Status
To view the status of the License Manager or a license file, run the LAU. 
Select a license file or server from the License File or Server drop-down 
list.

Each feature line in a license is displayed in the Licenses pane with verifi-
cation and count information. Select a product in the bottom pane, and 
click the Details button to access specific product details. You can also 
view the online help for more information.

Compuware Service Handler
The Compuware Service Handler provides system administrators with 
the ability to start and stop the License Manager. Administrators can also 
add, flush and view log files, or modify and reread license files. 

To start the Compuware Service Handler choose Services>LMGRD from 
the LAU. Only Administrators (machines designated as License Manager 
servers) will be able to select this item from the LAU Services menu. 
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Closing the Compuware Service Handler dialog box will NOT stop the 
License Manager from running as a service. 

Figure 4-7. Compuware Service Handler Dialog Box

Tip: The Compuware 
Service Handler will not 
open if the current 
machine's Host Name 
and HostID do not match 
the Host Name and 
HostID in the License File.

The following controls are located on this dialog box:

� Log File Name field — Designates the location of the log file where 
the License Manager writes its diagnostics. To select a local log file 
click the Browse button and navigate to the log file from within the 
Open dialog box. Compuware recommends specifying a log file 
before the Service is started so that License Manager diagnostics are 
recorded. 

Required: If a new log file is specified in the Log File Name field, its parent 
directory must exist.

� View Log File button — When clicked, a separate window is opened 
displaying the contents of the log file.

� Browse Log File button — When clicked, the Open dialog box 
appears and is used to navigate to an existing log file.

� Flush Log File button — Clears the contents of the log file specified 
in the Log File Name field. A good troubleshooting technique is to 
flush the log file when repeated errors occur before attempting to per-
form the step. This way the only items written into the log file will be 
the diagnostics pertaining to the error condition.
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� License File field — Used to specify the license file that the License 
Manager will use while it is running as a service. To change the 
license file, either type in the path to a new license file or use the 
Browse button to locate a valid license file.

� View License File button — Opens the license file specified in the 
License File field and displays it in a separate dialog box.

� Browse License File button — Used to locate a local license file.

� Edit License File button — Opens the license file specified in the 
License File field using Notepad or the system's default text editor.

� Start Service button — Starts the License Manager using the log file 
and license file specified in the fields in the Compuware Service Han-
dler dialog box. Compuware requires you to specify a log file before 
the service is started so that License Manager diagnostics are 
recorded.

� Stop Service button — Stops the current License Manager. A message 
will display asking if you want to run the License Manager as a Ser-
vice the next time the machine reboots. If you choose Yes, the 
License Manager will be added as a service on the machine where you 
are working. If you choose No, it will be removed and will no longer 
be a service.

� Reread Licenses button — Forces the License Manager to reread the 
license file specified in the License File field. Administrators would 
use this button after merging or updating the old license file. It is not 
necessary to stop or bring down the License Manager to reread a 
license file unless the SERVER or DAEMON lines are modified.

� Remove button — Used to remove an installed License Manager Ser-
vice.

� Help button — Used to launch online help.

Starting the License Manager

1 Open the LAU.

2 From the Services menu, choose LMGRD to open the Compuware 
Service Handler.

3 If the Compuware Service Handler reports that the License Manager 
is down, then:
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a Type the log file name in the Log file name field or click the 
Browse button to find and select the log file.

b Type the license file name in the License file field or click the 
Browse button to find and select the license file.

4 Click the Start Service button.

Stopping the License Manager

1 Open the LAU.

2 From the Services menu, choose LMGRD to open the Compuware 
Service Handler.

3 If the Compuware Service Handler reports that the License Manager 
is running, then click the Stop Service button to stop the License 
Manager as a service.

4 You will be asked if you want to start the LM as a Service the next 
time the machine reboots. Click Yes or No.

Stopping Redundant Servers

If you have a redundant server configuration established and you click 
the Stop Service button, a message will display giving you the option to 
stop one server or stop all three servers. It is important that you choose 
the stop all option. If you stop only one server, you run the risk of desta-
bilizing the license environment. For more information on redundant 
servers, see “Using Redundant License Servers” on page 17.

Rereading a License File

1 Open the LAU.

2 From the Services menu, choose LMGRD to open the Compuware 
Service Handler.

3 Click the Reread License file button.

Clearing the Log File

1 Open the LAU.

2 From the Services menu, choose LMGRD to open the Compuware 
Service Handler.

3 Click the Flush button.
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Chapter 5

License Borrowing
Overview of License Borrowing
License borrowing enables users to check out concurrent licenses from 
the License Manager (LM) and then use a Compuware product discon-
nected from the network. When a user reconnects to the network, the 
license can be checked back in, available for all users. 

The License Borrowing architecture consists of two components: 

� The Borrow Proxy Server (BPS) — allows concurrent licenses to be 
borrowed and system administrators can monitor license borrowing 
activity.

� For Windows, see “Borrow Proxy Server for Windows” on page 
62.

� For UNIX, see “Borrow Proxy Server for UNIX” on page 69.

� The Borrow License Client (BLC) — allows an end user to borrow 
and return concurrent licenses. This utility is only available for Win-
dows operating systems.

To enable License Borrowing, the following items are required:

� A concurrent license file with the keyword BORROW in a FEATURE 
line.

� The BPS installed in the same directory as the License Manager. 

� The BPS running whenever the License Manager is running.

� The BLC application installed on a client machine.
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Installing License Borrowing Components
Installation of License Borrowing components is handled with the instal-
lation of the License Manager (LM) for both Windows and UNIX. The 
Borrow Proxy Server (BPS) needs to be installed and run in the same 
directory as the License Manager. 

During installation of the License Manager, the new license file will be 
scanned. If it contains the keyword BORROW, the Borrow Proxy Server 
will be installed. The License Manager needs to be installed and running 
before the installation of the Borrow Proxy Server. 

The Borrow License Client (BLC) application needs to be installed on 
each client machine that can borrow licenses. A system administrator 
should verify that each client machine that will borrow licenses has the 
BLC installed. The BLC cannot be installed on the same machine as the 
Borrow Proxy Server (BPS).

For License Manager installation procedures on Windows, see “Installing 
the License Manager for Windows” on page 24; for UNIX, see “Installing 
the License Manager on UNIX” on page 34. 

Adjusting the Date and Time

Do not adjust the date/time on a client machine with a borrowed license. 
You will render the license inoperable and will not be able to use the 
license until after the number of days you established for the borrowing 
period has expired. 

Therefore, if you need to adjust the date/time, first return the license to 
the Borrow Proxy Server, change the date/time and then re-borrow the 
license. 

License Borrowing Process
The following is an overview of the licensing borrowing process:

1 The Borrow Proxy Server is installed with the License Manager as a 
Service by the System Administrator, each and every time the License 
Manager runs. 

2 A client installs a Compuware product, license file, and the Borrow 
License Client.

3 A client accesses the BLC application.

4 When the BLC loads, it communicates with the BPS to verify license 
status.
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5 The client selects a license to borrow.

6 The client enters the number of days to borrow the license.

7 The client commits the request by clicking the Apply button.

8 The BLC submits the request to the BPS. After authorization, the user 
can detach the laptop from the network and use the Compuware 
product remotely.

Figure 5-1. Borrow License Process Before a Transaction

After a successful borrow transaction occurs, a license file is created on 
the client machine and the Compuware product uses this license file. 
When running the Compuware product disconnected from the network, 
it is not necessary to have the BLC running. 
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Figure 5-2 shows the Compuware product and the License Borrow 
components after a request transaction is complete and the client is 
detached from the network.

Figure 5-2. Borrow License Process After Borrow Transaction

Borrow Proxy Server for Windows
The Borrow Proxy Server (BPS) is the application that provides the 
borrowing capability for Compuware products. The BPS is a proxy server 
that needs to run in conjunction with the License Manager (LM). This 
means that whenever the LM is running, the BPS must run. 

The BORROW keyword in the FEATURE line of a license file determines 
if the BPS will be installed. If your license file contains the keyword 
BORROW, installation of the BPS is required. If the BPS is installed, 
Compuware products will not run unless both the BPS and LM are 
running.

Tip: Compuware does not 
recommend using 
Windows 95, 98, or ME.

In addition to providing the borrowing capability, the Borrow Proxy 
Server dialog box can be used by system administrators to monitor and 
restrict License Borrowing. The Borrow Proxy Server dialog box is just a 
GUI to the service itself; if the BPS is hosted on Windows NT, 2000, or XP, 
users can shut down the dialog box and still use the BPS. If the BPS is 
hosted on Windows 95, 98, or ME, however, the GUI itself is the service/
console application and should not be shut down unless the License 
Manager is also brought down. 

The Borrow Proxy Server has two views:
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� The Borrowed Licenses view is the default view and displays the Host-
name, Product, Version, and Time remaining of all borrowed licenses. 
See Figure 5-3 on page 63. 

� The Policy Settings view displays the licenses that are available for 
the users to borrow. This view enables the BPS administrator to limit:

� Number of days a license feature may be checked out

� How many licenses are available for borrowing. For example, if 
Compuware license FEATURE x has 50 licenses, the administrator 
could limit the number of licenses that can be borrowed to 10, or 
any number less than or equal to the total number of licenses 
purchased.

Tip: For Windows NT, 
2000, and XP, the Borrow 
Proxy Server screen is only 
a portal to the service 
itself, so you may close 
the dialog box. For 
Windows 95, 98, and ME, 
the dialog box itself must 
remain open or the BPS 
will be stopped and 
licenses will not be 
authorized for checkout.

Figure 5-3. Borrow Proxy Server Dialog Box

Borrow Proxy Server Features

The following controls are located on the Borrow Proxy Server:

� Server Name field — Located in the top frame, it identifies the server 
name of the License Manager to which the BPS will connect. The 
server name is automatically known by the BPS if it exists in the same 
directory as the License Manager.

� Port Number field — Located in the top frame, it identifies the Port 
Number on which the License Manager is listening. To edit the Port 
Number field, stop the BPS and modify the value.
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� Policy Settings button — Opens the Borrow Policy Settings dialog 
box.

� Hostname item — Each represents a single client who has borrowed 
a license. Each Hostname item has the following attributes:

� Product — Licensed Compuware product name that has been 
borrowed

� Version — Version number of the product that was borrowed

� Time Remaining — Length of time before the borrowed license 
expires

� BPS-Status field — Contains status messages from the Borrow Proxy 
Server to the current user giving borrow transaction status.

� Start BPS button — Attempts to connect the Borrow Proxy Server to 
the License Manager. The License Manager must be running.

� Stop BPS button — Stops the Borrow Proxy Service.

� Borrow Policy Settings dialog box — Provides a system administra-
tor with the ability to control how many licenses and for how long 
each product license component may be borrowed. To modify the 
settings for a specific product, see “Changing Borrow Policy Settings” 
on page 66.

� Product item — Each Product item contained in the Borrow Pol-
icy Settings listing represents the type of features available in the 
license file. To change the defaults on a given Product item, select 
it and modify the Max Length field or the Reserved field.

� Reserved field — When a Product item is selected in the Borrow 
Policy Settings listing, the Reserved field will display allowing an 
administrator to Reserve a certain number of licenses that are not 
available for borrowing. For example, if the total license count for 
a given feature is 6, and 4 is entered into the Reserved field, only 
2 licenses will be available to borrow.

� Max Length field — When a Product item is selected in the Bor-
row Policy Settings listing, the Max Length field will display 
allowing an administrator to set the maximum number of days 
for which the selected product may be borrowed.

� Apply button — Applies changes made from the Max Length 
field or the Reserved field.
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Connecting to the License Manager 

In order to connect the Borrow Proxy Server to the License Manager, the 
License Manager must be running. The best way to connect the BPS to 
the LM is during the LM installation. See “Installing the License Manager 
for Windows” on page 24.

1 From the LAU’s Services menu, choose License Borrowing>Proxy 
Server to open the BPS dialog box.

2 Verify that the License Manager's Host name appears in the Server 
name field.

3 Verify that the License Manager's port number appears in the Port 
Number field. These items should appear automatically from instal-
lation.

4 Click the Start BPS button.

Monitoring Borrowed Licenses 

Use the default view (Borrowed Licenses) of the BPS to monitor borrowed 
licenses. When the BPS opens, all borrowed licenses will display in the 
Borrowed Licenses listing.
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Changing Borrow Policy Settings 

1 From the LAU’s Services menu, choose License Borrowing>Proxy 
Server to open the BPS dialog box.

2 Click the Policy Settings button and the Borrow Policy Settings dia-
log box displays. See Figure 5-4 on page 66.

Figure 5-4. Borrow Policy Settings Dialog Box

3 Select a product in the product listing.

4 To set the maximum number of days that a client can borrow a 
license of that type, type a number (can be 365 days or less) in the 
Max Length field.

5 To reserve a number of licenses that cannot be borrowed, type a num-
ber in the Reserved field.

6 Click the Apply button to save your changes.

7 Click the Close button to close the dialog box.

Starting the Borrow Proxy Server as a Service

The Borrow Proxy Server (BPS) can only be started on the machine that is 
hosting the License Manager (LM). The BPS must have been installed 
with the LM in order to start it. Compuware recommends that you install 
and run the BPS at the same time that you install and run the License 
Manager. See “Installing the License Manager for Windows” on page 24. 
This gives you the option of adding the License Manager and Borrow 
Proxy Server as services. 
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To start the BPS in Windows:

1 From the LAU’s Services menu, choose License Borrowing>Proxy 
Server to open the BPS dialog box. If the Proxy Server menu item is 
disabled, it means that the current machine is not a License Server 
(current machine is a client) or the current license environment does 
not contain a license file with a SERVER line.

Figure 5-5. Starting BPS from the LAU

When you select the Proxy Server menu command, it attempts to 
start the BPS service. However, if the Proxy Server is already running, 
the following error message will display.

Tip: If a user has more 
than one BPS defined, all 
defined Borrow Proxy 
Servers must be running 
for a user to invoke a 
served license that is 
borrow-enabled. 
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When the Borrow Proxy Server starts, the status of the License 
Manager is displayed, as shown in Figure 5-6.

Figure 5-6. License Manager Status Displayed on the Borrow Proxy Server

2 Click the Start BPS button on the Borrow Proxy Server. If the BPS is 
not already installed as a service in Windows NT, 2000, or XP, the fol-
lowing message appears:

� If you click the Yes button, the BPS will be installed as a service 
and run automatically each time the machine is rebooted. You 
will receive several messages stating the status of the automatic 
update and that other users must have your same permissions to 
run the BPS.

� If you click the No button, the BPS will run in the foreground of 
the current session.

3 The BPS - Status field will display messages indicating the success or 
failure of starting of the BPS.

License
Manager
status
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Stopping the Borrow Proxy Server

1 From the LAU’s Services menu, choose License Borrowing>Proxy 
Server to open the BPS dialog box.

2 Click the Stop BPS button. If the Stop BPS button is disabled, then 
the BPS is already stopped. 

3 A dialog box will appear asking if you want to start the BPS as a Ser-
vice the next time the machine runs. It is recommended that you 
choose Yes so that you do not have to manually restart the BPS when 
the Server boots. 

Stopping the BPS will prevent all License Borrowing by clients.

4 To manually uninstall the BPS, see “Uninstalling the License Manager 
or Borrow Proxy Server” on page 29.

Borrow Proxy Server for UNIX
The Borrow Proxy Server for UNIX can run on the following UNIX 
platforms:

� DEC

� HP-UX (32-/64-bit)

� IBM - AIX (32-/64-bit)

� Linux (Redhat Linux)

� Sun Solaris 2.x (32-/64-bit)

Installing the Borrow Proxy Server on UNIX

The Borrow Proxy Server is installed using the install script, during 
License Manager installation. 

Note: For complete License Installation details, see “License Installation and 
Management for UNIX” on page 33.

Starting the Borrow Proxy Server for UNIX

1 Verify that the Borrow Proxy Server is installed by navigating to the 
directory containing the License Borrowing Components. Type the 
following: $ls

2 You should see the files bps.run and bps.stat. If you do not see the 
files, re-run install (see “install” on page 42).
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3 Type in the following: $bps.run -c (license file) -p (port 
number) -l [log file]

4 This will create a file called bps.stop, which is used to shut down the 
Borrow Proxy Server.

5 See “Reporting on the Borrow Proxy Server for UNIX” on page 70.

Stopping the Borrow Proxy Server for UNIX

1 Navigate to the directory containing the License Borrowing Compo-
nents.

2 Type in the following: bps.stop

Reporting on the Borrow Proxy Server for UNIX

1 Navigate to the directory containing the License Borrowing Compo-
nents.

2 Type in the following: $bps.stat

3 If the Borrow Proxy Server is running, the following will display, oth-
erwise, you will get a message regarding the problem. 

bps.stat - Copyright (C) 2000,2001 Compuware Corporation

bps status: running

The following items describe the Header fields in the report above:

� User — Represents the user who has borrowed a product.

� Hostname — Represents the hostname of the user who borrowed the 
license.

� Feature — The product or feature that the user borrowed.

� Version — The version of the product that the user borrowed.

� dd:hh:mm:ss — Represents the time remaining in the borrowed 
license.

user hostname feature version dd:hh:mm:ss

=========== ========== ======== ======= ===========

Win_98.User fh18419 qaload 03.10 00:23:55:07

Win_98.User fh18419 xpdev 03.40 00:23:55:07

PFHSSSx sfa10xx6nt NPP 01.00 26:06:02:58

PFHSSSx sfa10xx6nt FE 02.70 00:23:55:07
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To set restrictions on the duration and amount of users that can borrow a 
license, see the next section.

Setting Restrictions on Borrow Enabled Licenses for the BPS for UNIX

A system administrator can create a special file that allows setting restric-
tions on the number of days a license can be borrowed, and how many 
licenses of a certain type can be borrowed.

1 Create a file named bps.cfg and place it in the same directory as the 
License Borrowing components.

2 Open the file. The file will be comprised of keywords, parameters, 
and comments when necessary. The file should follow the format 
below:

The following sample file shows how system administrators can create 
the bps.cfg file to restrict License Borrowing. 

Table 5-1. Keyword Definitions for bps.cfg

Keyword-Parameter syntax Definition

RESTRICT(prod_name, prod_version) Restrict designates the beginning of a FEA-
TURE restriction. Only FEATURE lines in a 
license file can have a RESTRICT.

•  prod_name — name of product as it is 
defined in the license file.

•  prod_version — version number of 
borrow-enabled product.

MAX_TIME(max_number_of_days) Maximum number of days a product can 
be borrowed. Cannot exceed 365 - which 
is BORROW maximum duration.

COMMIT(number_of_licenses) This is the number of licenses that are 
allowed to be borrowed. Cannot exceed 
available license count. 

This is the opposite of what happens with 
the keyword RESERVE.

RESERVE(number_of_licenses) This is the number of licenses that cannot 
be borrowed. Cannot exceed available 
license count.

This is the opposite of what happens with 
the keyword COMMIT.

END Ends a unique RESTRICTION BLOCK.

# Use the # sign for a comment.
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Required: Use either all caps, or all lower case, with keyword blocks in the 
following order: (1) RESTRICT (2) MAX_TIME (3) COMMIT (4) 
END. Max_time or commit may be omitted, but Restrict and End 
are required.

# bps.cfg

# THIS FILE IS USED TO RESTRICT LICENSES BORROWING 

# FOR ALL BORROW-ENABLED LICENSES

# // FIRST RESTRICT FEATURE. THE FOLLOWING RESTRICTS

# THE PRODUCT QALOAD, VERSION 03.10, TO ONLY 1

# LICENSE THAT CLIENTS CAN BORROW

restrict(qaload,03.10)

  commit(1)

end

# //SECOND RESTRICT FEATURE. THE FOLLOWING RESTRICTS

# THE PRODUCT XPDEV, VERSION 03.40, TO ONLY 10

# LICENSES THAT CLIENTS CAN BORROW FOR ONLY 30 DAYS

restrict(xpdev, 03.40)

   max_time(30)  

   commit(10)

end

Borrow License Client
The Borrow License Client (BLC) is a Windows-based application that is 
used to check licenses in and out of the Borrow Proxy Server. The user 
can then detach the client from the network and use the Compuware 
product with a borrowed license. This borrowed license is identical to the 
original license and allows the Compuware product to function as if it 
were connected to the License Manager. 

The Borrow License Client application is installed with the Compuware 
product and is in the same directory as the LAU. The BLC needs to be 
installed on the computer on which the Compuware product is installed 
(see Figure 5-2 on page 62).

Once a license has been borrowed, it is not necessary to start the BLC to 
run a Compuware product on a detached workstation. You only need to 
run the BLC to check out a license, to check in a license, or to view the 
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status of all checked out licenses on a client machine. When the BLC 
runs, it opens up in the “Edit Transactions” mode. In this mode, you can 
borrow and return licenses. The “Time Remaining” mode provides a 
listing of the Product, Version, and Time Remaining for each borrowed 
license. There are two buttons to toggle between the modes. 

Borrow License Client Features

To get started with borrowing licenses, review the available features on 
the Borrow License Client dialog box (see Figure 5-7), and then use the 
sections following these items to borrow and return licenses, and 
perform other license borrowing functions.

Figure 5-7. Borrow License Client Dialog Box

� Server field — Defines the server name where the Borrow Proxy 
Server is running. To define a Borrow Proxy Server, click the Define 
button and add a server in the Define Server dialog box. An alterna-
tive method to modify the values in the Server field is to open the 
bpsHosts.txt file. See “bpsHosts.txt file” on page 80.

� Define button — Opens the Define Server dialog box.
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� Del Entry button — Deletes the currently selected server from the 
Server field.

� Auto Return checkbox — Automatically returns all borrowed licenses 
to the Borrow Proxy Server when the client machine re-establishes a 
connection with the network (as long as Detach is not selected). The 
Auto Return checkbox is a true/false checkbox; meaning, if it is 
selected (true), it will remain selected until it is deselected (default, 
false). The default value is "not selected". If Auto Return is selected 
when the client reconnects, ALL licenses will be returned to ALL 
proxy servers defined in the Server drop-down field.

� Detach checkbox — Immediately forces the client's workstation to 
use Borrowed Licenses. The Detach checkbox is a true/false checkbox; 
meaning, if it is selected (true) it will remain selected until it is dese-
lected (default, false). If no licenses are borrowed, Compuware prod-
ucts will not run (unless connected to License Manager). Be sure to 
select the Detach checkbox after the licenses are checked out and to 
set it to false (default value, or not clicked) when reconnecting to the 
network.

The Detach functionality can be used to run a borrowed license if the 
network or server where the License Manager and Borrow Proxy 
Server are located is experiencing difficulty.

� Define Server dialog box — Allows clients to create separate loca-
tions for multiple Borrow Proxy Servers. Example: if there is a BPS on 
a UNIX box and also on a Windows box, two different connections 
can be established. It is possible to borrow licenses from any Borrow 
Proxy Server to which a client can connect. 

� Identifier — The unique name that will appear in the Server field 
of the BLC dialog box.

� BPS Hostname or IP Address — Defines the Hostname or IP 
Address of the Borrow Proxy Server to which the Borrow License 
Client will connect.

� BPS Listening Port — Identifies the TCP/IP port on which the 
Borrow Proxy Server is listening.

� Available Licenses item - Each product contained within the Avail-
able Licenses listing is a FEATURE line in the active license file that 
contains a BORROW keyword. This product may be borrowed by the 
client machine. When a Product item is selected with a mouse click, 
the Borrow button is enabled. Clicking the Borrow button will begin 
the transaction process. See “Enter the Number of Days Dialog Box” 
on page 79. The Available Licenses listing also includes the product 
Version item and the Expiration date item of the borrow transaction.
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� Borrowed Licenses item — Each product item within the Borrowed 
Licenses listing is a product that has already been borrowed (or will 
be when the Apply button is clicked). To return the item to the Bor-
row Proxy Server, click the Return button.

� Borrow button — Enabled when a Product item is selected from the 
Available Licenses listing. When clicked, the Enter the Number of 
Days dialog box will display.

� Return button — Enabled when a Product item is selected from the 
Borrowed Licenses listing.

� Apply button — Click the Apply button to enforce a given transac-
tion after the Borrow or Return buttons are clicked.

� Edit Transaction button — Clicked (selected) by default and pro-
vides the default view for the Borrow License Client. The default view 
contains the following:
� Available Licenses listing 
� Borrowed Licenses listing 

� Time Remaining button — Hides the Available Licenses and the Bor-
rowed Licenses listings and displays a larger version of the Borrowed 
Licenses listing, including the following fields:

� Product item — Displays each product that is currently Borrowed

� Version item — Lists the version number of each Product that is 
borrowed

� Server — Identifies the name of the Borrow Proxy Server (see 
Server field) from where the borrow request originated

� Time Remaining — Displays the time remaining of the borrow 
transaction in dd:hh:mm:ss format.

Borrowing a License

1 Open the LAU.

2 From the Services menu, choose License Borrowing>Client.

Tip: Contact your system 
administrator for the Host 
Name/IP Address and 
Port Number of the 
Borrow Proxy Server.

3 If the server name of the Borrow Proxy Server you want to connect to 
does not appear in the Server field of the BLC, click the Define but-
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ton on the BLC. The Define Server dialog box displays (see Figure 5-
8).

Figure 5-8. Define Server Dialog Box

4 In the Identifier field type in the server name, giving it a unique 
name of your choice.

5 In the BPS Hostname or IP Address field, type in the name given to 
you by your system administrator.

6 In the BPS Listening Port, type in the port number specified by your 
administrator.

7 Click the Apply button. The BLC - Borrow License Client dialog 
box displays (see Figure 5-7).

8 In the BLC's Available Licenses listing, select one or more products 
from the list. This will enable the Borrow and Apply buttons.

Figure 5-9. Available Licenses Listing

9 Click the Borrow button. The Enter Number of Days dialog box dis-
plays.

Files selected for 
borrowing

Borrow 
button

Apply 
button
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10 Enter the number of days for this borrow transaction. For additional 
information on borrow duration, see “Enter the Number of Days Dia-
log Box” on page 79.

11 Click OK. The licenses are moved from the Available Licenses listing 
to the Borrowed Licenses listing.

12 To complete the borrow process, click the Apply button.

Figure 5-10. Borrow Process

When apply is clicked, the Borrow, Return, and Apply buttons are 
disabled. The borrow transaction status is displayed in the “BLC - 
Status” screen.

13 The messages appear as follows:

***PROCESSING REQUESTS***

- ”PRODUCT NAME & VERSION” acquired

- ”PRODUCT NAME & VERSION” acquired

Detaching a Client from the Network

In the Server Information field at the top of the Borrow License Client 
screen, after one or more licenses are borrowed, select the Detach check-
box to immediately disconnect from the network. 

When the Detach checkbox is selected, Compuware products will use the 
borrowed license, even if the client is attached to the network. You can 
remove your network connection at any time.

At this point, the BLC utility can be shut down and the machine can be 
detached from the network. The Compuware product will display a 

Apply 
button

Licenses 
for 
borrowing

Status 
messages
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message with the number of days remaining on the borrowed license 
each time the product runs.

Returning a License

1 Reconnect the machine to the original network.

2 Open the LAU.

3 From the Services menu, choose License Borrowing>Client.

4 If the Auto Return checkbox is selected, then all licenses will auto-
matically be returned to all Proxy Servers when the Detach checkbox 
is deselected. Otherwise proceed to the next step.

5 Select the product to return in the Borrowed Licenses listing. This will 
enable the Return button.

Figure 5-11. Return Process

6 Verify that the Detach button is not selected.

7 Click the Return button. A message in the status screen will display 
the following:

A license for “PRODUCT NAME & VERSION” will be returned on 
APPLY.

8 To commit the return, click the Apply button.

9 The product license will be checked back into the License Manager 
via the Borrow Proxy Server. Resume step 5 for any remaining prod-
ucts to return.

Detach 
checkbox

Return button
License to 
be returned
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Enter the Number of Days Dialog Box 

The length of time that a license can be borrowed from the Borrow Proxy 
Server is specified when the Borrow button is clicked. This dialog box 
includes one field that takes an integer (a whole number) specifying how 
many full days the current borrow transaction will last, from 1 to 365. 

Note: The system administrator can limit the amount of days that a license 
can be borrowed using the Borrow Proxy Server. 

If a client does not return the license to the BPS before the license 
expires, two things will happen:

� On the client machine — the product that is checked out under the 
expired license will not run.

� On the server — the BPS will inform the License Manager that a 
checked out license has expired. The LM will make this license avail-
able to all users on the network.

Viewing the Status of Borrowed Licenses

The status of borrowed licenses can be seen in the Time Remaining mode 
of the Borrow License Client. 

Tip: Status for 
connections and 
transactions are always 
displayed in the “BLC- 
Status” screen.

To view the time remaining for borrowed licenses, click the Time 
Remaining button on the Borrow License Client dialog box. When this 
button is clicked, the Available Licenses and Borrowed Licenses listings 
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are hidden and replaced with an expanded version of the Borrowed 
Licenses listing which includes Server and Time Remaining columns.

Figure 5-12. Time Remaining Listing

Click the Edit Transaction button to return to the Borrow License Client 
dialog box default view.

bpsHosts.txt file

The bpsHosts.txt file contains the strings for the server field in the 
Borrow License Client. In Windows, these items can be created using the 
Define Server dialog box (see Figure 5-8 on page 76). In UNIX, these 
strings can be manually typed in the bpsHosts.txt file which is located in 
the same directory as the Borrow Proxy Server.

Note: To ensure that each client connects to the correct Borrow Proxy 
Server, a single file can be created and copied into each client's 
Borrow License Client directory. 

The following is an example of what is in the bpsHosts.txt file:

# comment

server (UNIX Workstation, productionEnt4500, 7123)

The following terms describe the example from above:

server = keyword

UNIX Workstation = Name of the BPS location

productionEnt4500 = Host Name or IP address of BPS 

7123 = port on which BPS is listening
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Chapter 6

Remote License Administration 
Utility
Overview of Remote License Administration Utility
Distributed License Management's Remote License Administration Utility 
(RLAU) provides a central point of license administration. The file for the 
utility (dlmCGIAdmin) is on the product CD or copied onto the product 
directory, and the RLAU must be run on an HTTP server. It allows the 
administrator to view the current status of authorized License Managers 
through a user-friendly web interface without being present at the server.

Figure 6-1. The Remote License Administration Utility

Client/server administration capabilities include:

� Obtaining the current status of the License Manager

� Examining license usage

� Viewing contents of the current log, license, and options files
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The RLAU consists of several components. These components include a 
Java-applet, a User Configuration/Administrative Tool, and a CGI. 

Unlike the applet portion of the RLAU, the CGI module and User Config-
uration Tool are non-Java applications, which means that unique 
binaries exist for each supported platform. 

Installing and Configuring the RLAU

The following steps are necessary to install and configure the Remote 
License Administration Utility in your environment:

1 Install the License Manager and its components.

� For Windows, see “Installing the License Manager for Windows” 
on page 24.

� For UNIX, see “Installing the License Manager on UNIX” on page 
34.

2 Create User Accounts. See “Creating User Accounts” on page 84.

3 Define the License Manager. See “Defining the License Manager” on 
page 86.

4 Configure the vendor daemon to allow streaming of information.

� For Windows, see “Configuring in Windows” on page 87.

� For UNIX, see “Configuring in UNIX” on page 88.

5 Install the CGI as a service. See “Installing the CGI” on page 88.

6 Run the RLAU. See “Configuring the Java Applet” on page 89.

Tested Environments

Required: The Java-applet component requires that client systems that 
access the applet via a browser, such as Netscape or Explorer, have 
a minimum of Java 1.3 installed for Java support.

The RLAU was tested and will work properly in the following environ-
ments.

Web Servers

� Apache on UNIX Solaris 8.0

� IIS on Windows 2000 Server

� iPlanet on Windows NT Server and Solaris 8.0
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Browsers

� Internet Explorer 5.5 and 6.0

� Netscape 6.2

Note: Java Plug-in 1.3 and 1.4 for Netscape 6.2 is not supported in the AIX, 
HP, and Redhat environments.

Functions of the RLAU

The RLAU provides remote review of FLEXlm-based Compuware License 
Managers and their environments. The following diagram illustrates the 
interaction between the provided Java-applet component and the CGI.

Figure 6-1. Java Applet Component and CGI Interaction

Only authorized clients can access the data from a License Manager. User 
account definitions define the access rights of individual users to a partic-
ular License Manager. The CGI Administrative Tool administers user 
accounts for remote License Manager access. 
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Supported Platforms
The platforms supported by these components are AIX, SunOS, OSF, HP-
UX, Windows XP, Windows NT, and Linux. An administrator with root 
access to the machine should perform installation and/or configuration 
of these components. 

The following chart shows the binary to platform relation of all binary 
components provided for the RLAU.

Note: 64 = 64 bit version.

Creating User Accounts
To create user accounts, run the dlmCGIAdmin executable file for the 
platform that corresponds to the system that you have designated as your 
HTTP server. The dlmCGIAdmin file has a text based GUI which means 
that it can be run in a text based terminal window, such as Telnet. 

Required: You should have root or administrative access to the HTTP server 
before running the component.

Table 6-1. Supported Platforms

Platforms Component List

Windows XP and 
Windows NT

dlmCGIInstaller.exe, dlmCGIProcess.exe, 
dlmCGIAdmin.exe

Linux, HP-UX, HP-UX 
64, OSF/Digital, AIX, 
AIX 64, SunOS/
Solaris, and SunOS/
Solaris 64

dlmCGIProcess <platform>, dlmCGIAdmin <plat-
form>, aes
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To run the dlmCGIAdmin component:

1 At the command prompt, type dlmCGIAdmin <platform> or 
dlmCGIAdmin.exe to display the dlmCGIAdmin Main Menu 
screen (see Figure 6-2). 

Figure 6-2. dlmCGIAdmin Main Menu Screen

2 Type U and press Enter to access the User Database Menu.

3 Type N and press Enter to add a New User to the User Database.

4 Type a user name and press Enter.

5 Type a password for the newly created user and press Enter.

6 Re-type the password for confirmation and press Enter. A message 
will appear on the screen to confirm that the user was added to the 
user database.

7 Press Enter to add another user and repeat steps 3 through 6.

8 To return to the Main Menu, press Enter three times.

Only users with accounts will have access to the License Managers. User 
accounts are added to the dlm_password file that is located in the /etc 
directory for UNIX platforms and the C:\Windows directory for 
Microsoft OS platforms.
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Defining the License Manager
Before interaction between a client (Applet) and a License Manager can 
occur you must identify the License Manager to the CGI. To define the 
License Manager:

1 From the Main Menu of dlmCGIAdmin, type H and press Enter to 
access the Host Database Menu screen (see Figure 6-3).

Figure 6-3. dlmCGIAdmin Host Database Menu Screen

2 Type A and press Enter to add a host name or TCP/IP address.

3 Type the host name or TCP/IP address of the License Manager to be 
added and press Enter. 

Note: The TCP/IP address can be either the hostname-alias or the actual IP 
address of a system that is running the License Manager.

4 Type an alias name for the host and press Enter.

� If an alias is specified the alias is displayed on the client instead of 
the TCP/IP identifier of the License Manager. References to the 
License Manager can use either the alias or the hostname. 

� If an alias is not specified, only the host name or TCP/IP address, 
whichever is supplied during the creation of the host entry, can 
be used to identify a License Manager. 

5 Type the port number where the License Manager is listening and 
press Enter. The port number can be found on the SERVER line of 
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your license file. A message will appear on the screen to confirm that 
the alias and host was added to the host database.

6 Press Enter to add another host and repeat steps 3 through 5.

7 Press Enter three times to return to the Main Menu.

8 Type U and press Enter to access the User Database Menu.

9 Type A and press Enter to add a host to a user's account.

10 Type the name of the user from the list displayed and press Enter.

11 Type the host name or TCP/IP address or alias of the License Manager 
where the user needs access and press Enter. A message will appear 
on the screen to confirm that reference to the host name was added 
for the user.

12 Press Enter to add another host reference to a user’s account and 
repeat steps 10 and 11.

13 Press Enter three times to return to the Main Menu.

14 Type E and press Enter to exit.

Configuring the Compuware Vendor Daemon to Accept 
Requests

There are two levels of security provided for support of Web-browsing. In 
addition to defining user accounts for the CGI, each vendor daemon 
must also be authorized to allow the streaming of information. There-
fore, although a user can have access to a License Manager in their 
account description, the License Manager still has the ability to block all 
requests.

Configuring in Windows

To configure the Compuware Vendor Daemon in Windows:

1 Run cpwrDiag.exe (found on the product CD).

2 Click the License Manager(5) tab. 

3 Select the checkboxes Enable remote review of the log file and 
Enable remote review/edit of the license file.

4 Click the Exit/Close button.
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Caution: If you do not configure the Compuware Vendor Daemon, you 
will not be able to view the license file information in the License File Tab 
and/or the log file information in the Log File Tab of the RLAU. 

Configuring in UNIX

From within UNIX, you must run the aes configure script to define the 
location of the license file and log file and to make sure they are pointing 
to the same license. If they are not, the log file will not match the license 
file when viewing them in the RLAU.

Installing the CGI
The CGI component of the RLAU provides interaction between the client 
and a specific License Manager. The CGI only allows one client at a time 
to communicate with an individual License Manager. Before accessing a 
License Manager from a remote location, a client-user must have a regis-
tered account with the CGI. 

Once you have configured your user accounts (see “Creating User 
Accounts” on page 84) and the individual License Managers (see “Defin-
ing the License Manager” on page 86), you will need to install the CGI to 
start it on the HTTP server. 

Windows NT, 2000, and XP

Before you can run the CGI on a Windows HTTP server you must first 
install it as a service. The dlmCGIInstaller is used to run, install, remove, 
and start the dlmCGIProcess. To install and execute the CGI as a service:

1 Determine a port number where you want to run CGI.

2 Type the following command at a DOS command prompt: 

dlmCGIInstaller -i -p <port number> -e 

This action does not need to be performed again. You only need to install 
this dlmCCIInstaller once.

Checking the Status
Tip: At the DOS 
command prompt, type 
dlmCGIInstaller -h 
to show other options.

To check the status of the dlmCGIInstaller, enter the command dlmCGI-
Installer -st at the DOS command prompt.
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Windows 95, 98, ME, and UNIX

In a Windows 95, 98, ME, or UNIX environment, the CGI is started at the 
command line or placed in a UNIX rc-startup file. To start the CGI at the 
command line type the following command: 

dlmCGIProcess -p <port number>

Configuring the Java Applet
After you start the CGI, you can then run it on the HTTP server. To run 
the RLAU:

1 Copy the DLM_Web_Tool folder found on the product CD to a loca-
tion on your HTTP server. The location on your server should be des-
ignated as the site location for the RLAU application.

2 Open the DLMAdminTool.html file.

3 Change the port number in the source code of the DLMAdmin-
Tool.html file to match the port number you defined when starting 
the CGI (see “Installing the CGI” on page 88). 

4 Create a link from your intranet site to the RLAU.

Example: 

http://sitename/dlmweb/DLMAdminTool.html

5 To access the RLAU, direct users to the site address you created.
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Launching the Remote License Administration Utility 

Logging into the RLAU

To log into the Remote License Administration Utility, follow the steps 
below.

1 Open the RLAU in a browser window using the site address provided 
by the system administrator. The RLAU Login Screen will display in 
your browser window (see Figure 6-4).

Figure 6-4. RLAU Login Screen

2 Type your User ID and password in the User ID and Password fields. 
The User ID and password must be created by the system administra-
tor. See “Creating User Accounts” on page 84.

3 Click the Login button. 

� The Login button will not be available until you type a password 
in the Password field.

� The Reset button is enabled after you click the Login button. To 
restart the login process, click the Reset button to clear the User 
ID and Password field and to remove any errors and the License 
Manager drop-down list.

4 Select a License Manager from the drop-down list. 

5 Click the Connect button.
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After you log into the RLAU and it is loading in your browser, it may 
seem that the application is not launching because the screen looks 
inactive. However, the way to distinguish whether or not it is running is 
to look in the bottom left-hand corner of the screen. If you see the 
following messages, then the application is loading. 

Applet started.

Busy contacting server. Please wait...

Loading the RLAU

If the application takes an unusually long amount of time to load after 
logging in and selecting a server, and your license and log files contain 
numerous features and users, you may perform any or all of the follow-
ing tasks to decrease the load time of the RLAU.

1 Flush the Log file. This should be done periodically to increase 
streaming.

2 Disable the remote review of the log file and/or license file. (See 
“Configuring in Windows” on page 87.)

If however, you do not get a connection to the RLAU and it does not 
load, open your Java Console to determine the error and contact Compu-
ware’s Technical Support.
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Appendix A

USER_BASED/HOST_BASED 
License Models
Overview of USER_BASED/HOST_BASED License Models
USER_BASED and HOST_BASED license models are similar to the concur-
rent license model except that they allow an administrator to restrict 
certain users/machines from checking out a license through the use of an 
Options File. These license models require the use of the License 
Manager. 

The concurrent license, specified by Compuware, must be a counted 
license with a user count of 1 or more. These license models use a text file 
called an Options File to specify the licensed users or hosts and the 
Options File must be specified on the DAEMON line of the Compuware 
license file. Therefore, two changes are necessary in order to implement 
this license model: changing the license file and adding an Options File. 

The following sections provide an overview for creating an Options File 
to implement USER_/HOST_based licensing and modifying the concur-
rent license file.

Creating an Options File
Tip: Use the keyword 
INCLUDE for 50 users or 
less. Use the keyword 
GROUP for more than 50 
users.

There are several keywords necessary to create an Options File. The two 
most important keywords are INCLUDE and GROUP. These two 
keywords are described in more detail below. For more Options File 
keywords and information, contact GLOBEtrotter Software for a FLEXlm 
User’s Guide.

Note: Do not use Notepad to create an Options File; use another standard 
text editor. On some platforms, invalid characters are inserted that 
will be misinterpreted by FLEXlm. Please contact Technical Support 
at 1-800-538-7822 for assistance in creating the Options File using 
the Compuware License Diagnostics Tool.
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Refer to the following sections for instructions on creating an Options 
File. 

Implementing a USER_/HOST_based License Model

The following steps provide an overview for creating an Options File to 
implement USER_/HOST_based licensing. 

1 Specify a name for the Options File within the license file. 

If the Options File location is not in the same directory as the license 
file, specify the complete path.

The Options File path must be specified on the DAEMON line of the 
Compuware license file. It is recommended that you use the full path 
name for the Options File. Compuware suggests that you use the 
suffix ".opt" in the file name. For example:

DAEMON compuware compuwar <full path to license> compuwar.opt

2 Add the HOST_BASED or USER_BASED literal to the 
FEATURE_LINE. 

For example:

FEATURE test compuware 1.000 1-dec-1999 2 DCA6EE6A58F94072F0F7\

  VENDOR_STRING=999999;0;PERM USER_BASED ck=101

Tip: The license type 
specification is in 
uppercase and usually 
appears after the 
VENDOR_STRING field. 

3 Create an ASCII text file (Options File) and name it the same name 
used in step 1 above. This file is created and updated at the customer 
site.

4 Enter your USER, HOST, or GROUP parameters in the Options File. 
See “INCLUDE Keyword” on page 95 and “GROUP Keyword” on page 
96.

Modifying the License File for USER_/HOST_Based Licensing

The following is an example of a complete license file where feature "test" 
is USER_BASED and "test2" is HOST_BASED:

#Start of license file example
SERVER fh18419 00c04f35d091 TCP:7166

DAEMON compuware compuwar <full path to license> compuwar.opt

FEATURE test compuware 1.000 1-jan-0000 2 \
DCA6EE6A58F94072F0F7 \
VENDOR_STRING=999999;0;PERM USER_BASED \
ck=101

FEATURE test2 compuware 1.000 1-jan-0000 3\
9C668E6A5C3CF3C0DB7E \
VENDOR_STRING=999999;0;PERM HOST_BASED \
94     License Installation Guide



 

ck=81
#end of license file example

INCLUDE Keyword

The INCLUDE statement is used to specify a licensed user or host for 50 
users or less, the syntax is:

� <product> — The name of the Compuware product. It is possible to 
define a specific version of a product by appending a colon followed 
by the desired version. For example, "test:version=1.1" would only 
allow specified users or hosts to run version 1.1 of the specified prod-
uct. If the version modifier is omitted, all versions of the product can 
be accessed. There are additional modifiers that are not covered in 
this document.

� USER/HOST — Specify as USER for USER_BASED; or HOST for 
HOST_BASED licenses.

� <name> — Name of the USER or HOST licensed to run the product. 
Please note that host or user name is case sensitive and must match 
the name used by the network name server.

Below is a possible option file for the above license file example:

Figure A-1. Options File Example 1

INCLUDE test USER user1
INCLUDE test USER user2
INCLUDE test2 HOST xx18929
INCLUDE test2 HOST xx18419

In this example, user1 and user2 are licensed to run all versions of 
product "test" and machines xx18419 and xx18929 are licensed to run 
all versions of product "test2". Please note that the license file above 
specifies a maximum of two users for product "test" and a maximum of 
three hosts for product "test2". 

In this example, all possible users are defined. Any additional users or 
hosts specified as licensed users are ignored and therefore not licensed to 
run the product. For example, if there were four hosts defined for product 
test2, only the first three host specifications would be used. You have the 
option of changing or adding names of users or hosts up to the specified 
license count. You cannot specify more users than the license file allows. 

If the Options File does not exist, there are no licensed users for the 
product. If a user tries to acquire a license and is not specified as a legal 

INCLUDE <product> s co t <name>USER

HOST
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user, an error code -39 will appear indicating the user or host has not 
been specified in the Options File as a licensed user or host.

GROUP Keyword

In lieu of using individual users within the INCLUDE statement, the 
GROUP keyword can be used to define a grouping of more than 50 users. 
The GROUP keyword appears at least two times: (1) One for each Group 
to include (2) One within the INCLUDE statement to specify a GROUP 
name.

Tips For Using the GROUP Keyword

� The GROUP keyword must be defined before the INCLUDE statement.

� A separate INCLUDE statement is required for each GROUP defined.

� The number of users that can be included in a single GROUP is lim-
ited to no more than 100 users.

Figure A-2. Options File Example 2

Syntax

GROUP group_name user1 user2 userN

INCLUDE YourProductName GROUP group_name

Example

GROUP Development jillJack janeDoe marySmithe

GROUP Testing wsWrite satchPage johnDoe

INCLUDE YourProductName GROUP Development

INCLUDE YourProductName GROUP Testing
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Appendix B

Host Name, Host ID, and 
HOSTID String
Overview
The Host Name is the unique name that identifies a computer on a 
network. A computer may have several of these (aliases). The Host ID is 
the machine identification number of a Host. For Windows PCs, this is 
the Ethernet Card ID. HOSTID is a string found in a line below the 
FEATURE line of a license file and typically is the ethernet card of a 
machine. 

Host Name and Host ID 
To obtain a license for your Compuware product, you must provide the 
host information of the machine on which the license will reside. If a 
License Manager is required, this is the server machine. You need to 
supply Compuware with the Host ID of the server on which the License 
Manager will run, not the Host IDs of all of your clients. If no License 
Manager is required, this is the same machine on which the product is 
installed. 
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To determine Host information to send to Compuware to request a 
permanent license:

After you receive your license file from Compuware, you can find your 
Host Name and Host ID for your Concurrent licenses in the first line of 
the license file:

Table B-1 Determining Host Information of Computer

Platform Step Action

Windows 1 Start the LAU.

2 From the File menu, choose Save.

3 Choose a directory and click the Save button. A text file 
(named HostInfo.txt) is saved in this location.

4 Provide the file to Compuware or locate the Host Name and 
Host ID in the file and supply that information to Compu-
ware.

UNIX 1 Navigate  to the directory in which the License Manager is 
located (for example, /cpwr/license).

2 Type uname -n. A message like the following is displayed: 

Host Name = fh5222dt.

3 Type lmutil lmhostid. A message like the following is 
displayed:

FLEXlm host ID is "00c04fd9ed02.

4 Provide the Host Name and Host ID information to Compu-
ware.

SERVER 
keyword

Host name Host ID Port on which the Host is 
listening for requests

SERVER sfa15155 00c05f581a0e TCP:7166
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HOSTID
The HOSTID string is only found in Node-Locked licenses and defines 
the Host ID of the client that can execute a given feature. See the 
example below:

The typical values for HOSTID are either a Host ID from a machine or the 
keyword “ANY”. If you see the keyword “ANY” in your license file, the 
license can run a feature on “any” single client machine, based on the 
license terms and conditions.

ABCD33NDDMEKK3K \

VENDOR_STRING=989898;0;PERM \

HOSTID=00c00f47fa0e ck=110

FEATURE xpdev compuware 03.40 1-jan-2001 3
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Glossary
Borrow License Client (BLC): Allows an end user 
to check licenses in and out. This utility is only 
available for Windows operating systems.

Borrow Proxy Server (BPS): An application that 
allows concurrent licenses to be borrowed and 
system administrators can monitor license 
borrowing activity. The BPS is a proxy server 
that runs in conjunction with the License 
Manager.

Compuware Service Handler: Provides system 
administrators with the ability to start and stop 
the License Manager.

Concurrent-user license: This type of license 
model allows the product to run on more than 
one workstation so that multiple users can 
access the product. When all available license 
are checked out, no additional users can run the 
product until a license is checked back in. 
Permanent and temporary licenses are types of 
concurrent-user licenses.

Daemon: The vendor daemon is used to count 
(or check licenses in and out) concurrent-user 
licenses. If your license contains server and 
daemon lines without a # sign in front of them, 
it is a concurrent-user license that is to be 
installed on a machine dedicated as the server. 
Literally, daemon is an acronym ‘Disk And 
Execution MONitor’. It is a program that is not 
invoked explicitly, but lies dormant waiting for 
some condition(s) to occur. The idea is that the 

perpetrator of the condition need not be aware 
that a daemon is lurking (though often a 
program will commit an action only because it 
knows that it will implicitly invoke a daemon).

Floating license: See concurrent-user license.

Host name: A unique name that identifies a 
computer on a network. A single computer can 
have several host names, also called aliases.

Host ID: The machine identification number of 
a host. For Windows PCs, this would be the 
Ethernet address of the network interface card.

LAU: See License Administration Utility.

License Administration Utility (LAU): This is a 
Windows-based GUI designed to help you set 
up and manage your license files and set your 
environment. By using this utility, you do not 
have to manually type in information or open 
the license file in a text editor and risk corrupt-
ing your file or typing the information incor-
rectly. You can view details of a product license 
and get hints to solve many of your licensing 
errors.

License File (license.dat or license.lic): A data file 
that contains information about the Compu-
ware products (clients and locations) and the 
License Manager.

License Manager: Compuware’s License Manager 
contains the FLEXlm license server component 
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and the License Administration Utility. Both of 
these components enable the License Manager 
to check licenses in and out and maintain the 
master license file.

License Manager server: The dedicated machine 
upon which you will install the Compuware 
License Manager. 

LM: See License Manager.

LMGRD: The License Manager application itself 
using the Compuware Service Handler inter-
face.

Master license file: This is the repository for the 
licensing information for all the products you 
have installed on your machine. When you get 
a new product license, you will append that 
information to the master license file using the 
License Administration Utility.

Network license: See concurrent-user license.

Node-locked license: This type of license model 
allows the product to run on a single, specified 
workstation (node). The product cannot be used 
on any other workstation. Permanent, tempo-
rary, and trial licenses are types of node-locked 
licenses.

Permanent license: This type of license gives you 
access to the product under the terms of your 
contract with Compuware. Compuware offers 
two types of permanent licenses: node-locked 
and concurrent-user.

RLAU: See Remote License Administration 
Utility.

Remote License Administration Utility (LAU): This 
utility allows a remote administrator to review 
License Manager configurations via a web 
browser. Functionalities include viewing the 
log, license, and options files. In addition, this 
tool offers the ability to monitor the usage of 
Compuware products and the state of the 
License Managers that support them.

Server: On a local area network, a computer 
running administrative software that controls 
access to the network and its resources, in this 
case the product licenses, and provides 
resources to computers functioning as worksta-
tions (client machines) on the network.

Single-user license: See Node-locked license.

Temporary license: A temporary license has a 
fixed expiration date from the time it is 
installed on your system. You must request this 
license from Compuware’s Technical Support. 

Terminal Services: Terminal Services provides 
functionality similar to a terminal-based, 
centralized host, or mainframe, environment in 
which multiple terminals connect to a host 
computer. Each terminal provides a conduit for 
input and output between a user and the host 
computer.

Trial license: This type of licensing is installed 
when you install your Compuware product and 
it allows you to run the product for a specific 
time period (typically 14-45 days from the day 
you install the product).
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License Borrowing 59

Process 60
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Reread Licenses button 57
RESERVE 71
Reserved field 66
RESTRICT 71
Restrict License Borrowing 62
Return a License 78
Return button 75
RLAU 81

see Remote License Administration Utility

S
SERVER 57
Server 75
server

definition of 102
server (Unix Workstation, productionEnt4500,

7123) 80
Server field 73
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